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RESUMO 

 

 

O saneamento básico está diretamente relacionado a redução de doenças, melhora da saúde e 

aumento da produtividade humana, além da conservação ambiental e valorização econômica. 

Apesar disso, a região Nordeste do Brasil ainda sofre com a precariedade no abastecimento de 

água tratada, sendo que 30% da população não tem acesso a esse direito básico. Nesse 

sentido, o objetivo do presente trabalho é encontrar as melhores regiões para localização e 

implementação de uma ETA no Estado do Ceará e verificar a viabilidade econômica dos 

cenários construídos. Para isso, utilizou-se da modelagem computacional para otimização das 

rotas da Operação Carro-Pipa - OCP, e do geoprocessamento via ArcGIS para processamento, 

integração e análise dos dados geográficos para inclusão de novos pontos de ofertas de água, 

as ETAs. Esse processo gerou 54 novos cenários de produção, distribuição e consumo de água 

que se diferem na distância entre a ETA, os mananciais e as prefeituras administrativas, na 

capacidade de produção e na quantidade de ETAs. Esses cenários foram analisados e 

confrontados com a realidade de abastecimento por caminhões pipa da OCP para verificar a 

viabilidade econômica de cada um deles em comparação ao abastecimento atual. Para tanto, 

dentre as opções analisadas, verificou-se que a economia gerada de cada cenário justifica a 

implementação de uma ETA, independente da sua capacidade. Portanto, a construção de uma 

estação de tratamento de água nas localizações levantadas e analisadas apresentaram valores 

favoráveis e positivos aos critérios de viabilidade econômica. Verificou-se, assim, que a 

implementação de ETAs no estado do Ceará é viável economicamente e traria inúmeros 

benefícios sociais e ambientais para a região. 

 

 

 

Palavras-chave:  Saneamento básico; Tratamento de água; Modelagem; Geoprocessamento 



 

 

ABSTRACT 

 

 

Basic sanitation is directly related to reducing diseases, improving health and increasing 

human productivity, besides to the environmental conservation and economic enhancement 

issues. Despite that, the Northeast region of Brazil still suffers from precarious supply of 

treated water since 30% of the population doesn’t have access to this basic right. Thus, the 

aim of this work is to find the best regions to locate and implement Water Treatment Plant -

WTP in the State of Ceará verifying its economic viability. Computational modeling was then 

used to optimize the routes of Operation Carro-Pipa - OCP, and geoprocessing via ArcGIS for 

processing, integration and analysis of geographic data to include new water supply points, 

i.e. water treatment plants. This process generated 54 new water production, distribution and 

consumption scenarios differing in the distance between the WTP, the water sources and the 

administrative municipalities, in the production capacity and in the number of WTPs. These 

scenarios were analyzed and confronted with the reality of supply by water trucks, from OCP, 

to verify the economic viability of each one of them compared to the current supply. Among 

the options analyzed, it was found that the savings generated in each scenario justifies the 

implementation of an ETA, regardless of its capacity. Therefore, the construction of a water 

treatment plant in the locations surveyed and analyzed presented favorable and positive values 

to the criteria of economic viability. It was then found that the implementation of WTPs in the 

state of Ceará is economically viable bringing numerous social and environmental benefits to 

the region. 

 

 

Key Words:  Sanitation; Water treatment; Modeling; Geoprocessing. 



 

 

LISTA DE FIGURAS 

 

Figura 1: Captação Global de Água ......................................................................................... 17 
Figura 2: Estresse Hídrico Anual.............................................................................................. 19 

Figura 3: Processo de Solução de um Problema de PO ............................................................ 28 
Figura 4: Classificação do Modelo de Simulação .................................................................... 31 
Figura 5: Adequação de Diferentes Técnicas de Modelagem em relação à Variabilidade e 

Complexidade do Modelo ........................................................................................................ 33 
Figura 6: Estrutura do Método Simplex ................................................................................... 39 

Figura 7: Formatos do Modelo de PL para Solução via Método Simplex ............................... 40 

Figura 8: Problemas básicos de transportes e suas interconexões ............................................ 43 
Figura 9: Estrutura Geral de Sistema de Informação Geográfica ............................................. 51 

Figura 10: Conceito de SIG ...................................................................................................... 52 
Figura 11: Representação de Dado Gráfico – imagem raster e feições vetoriais .................... 53 
Figura 12: Visão Geral das Inter-relações no Processo de Elaboração do Projeto ................... 56 
Figura 13: Critério de Estudo de Engenharia Econômica ........................................................ 57 

Figura 14: Integração dos Dados do Estudo ............................................................................. 66 
Figura 15: Mapa de Distâncias Euclidianas entre Mananciais ................................................. 69 

Figura 16: Mapa de Distâncias Euclidianas entre Prefeituras Administrativas ....................... 69 
Figura 17: Mapa de Estresse de Água ...................................................................................... 70 

Figura 18: Mapa de Ganho de Otimização por Mananciais ..................................................... 70 
Figura 19: Mapa de Ganho de Otimização por Prefeituras Administrativas ............................ 70 
Figura 20: Mapa de Volume Demandado................................................................................. 71 

Figura 21: Mapa de Volume Ofertado ...................................................................................... 71 
Figura 22: Mapa das Regiões para Localização das Estações de Tratamento de Água ........... 73 

Figura 23: Exemplos de Resultados em Formato CSV ............................................................ 76 
Figura 24: Mapa de Localização das Estações de Tratamento de Água .................................. 81 



 

 

LISTA DE QUADROS 

 

Quadro 1: Teoria Geográfica e Geoprocessamento .................................................................. 48 
 

 



 

 

LISTA DE TABELAS 

 

Tabela 1: Dados sobre a Operação Carro-Pipa do Governo Federal ........................................ 22 
Tabela 2: População residente, por situação do domicílio sexo e idade, segundo a condição do 

domicílio ................................................................................................................................... 53 
Tabela 3: Exemplo dados de oferta .......................................................................................... 74 
Tabela 4: Exemplo dados de demanda ..................................................................................... 75 
Tabela 5: Exemplo de dados de distâncias ............................................................................... 75 
Tabela 6: Economia gerada em porcentagem dos cenários construídos .................................. 78 

Tabela 7: Economia gerada em reais do Cenário 222-222 ....................................................... 82 

Tabela 8: Economia gerada em reais do Cenário 555-555 ....................................................... 82 
Tabela 9: Economia gerada em reais do Cenário 888-888 ....................................................... 83 

Tabela 10: Economia gerada em reais do Cenário 2&8 ........................................................... 83 
Tabela 11: Custos de implementação de uma ETA por capacidade de entrega dos carros-pipa

 .................................................................................................................................................. 85 
Tabela 12: Custo anual de consumo de energia elétrica por capacidade de entrega dos carro-

pipa ........................................................................................................................................... 86 
Tabela 13: Payback em meses dos cenários construídos ......................................................... 87 

Tabela 14: Valor presente líquido – VPL dos cenários construídos......................................... 88 
 



 

 

SUMÁRIO 

 

1 INTRODUÇÃO .............................................................................................................. 11 

2 OBJETIVO ..................................................................................................................... 13 

2.1 Objetivo Geral ................................................................................................................ 13 

2.2 Objetivos Específicos ...................................................................................................... 13 

3 REVISÃO BIBLIOGRÁFICA ...................................................................................... 14 

3.1 A água e o Nordeste ........................................................................................................ 14 

3.2 Pesquisa Operacional ..................................................................................................... 23 

3.2.1 História da Pesquisa Operacional ............................................................................. 23 

3.2.2 Definição de Pesquisa Operacional .......................................................................... 24 

3.2.3 Etapas de um estudo de Pesquisa Operacional ......................................................... 25 

3.2.4 Modelo de Pesquisa Operacional ............................................................................. 29 

3.2.5 Técnicas de Pesquisa Operacional ............................................................................ 31 

3.2.6 Programação Linear .................................................................................................. 34 

3.2.6.1 Uma forma-padrão do modelo .............................................................................. 35 

3.2.6.2 Terminologia para soluções de Modelo ............................................................... 36 

3.2.6.3 Hipóteses .............................................................................................................. 37 

3.2.6.4 Formulação de modelos de PL de grandes dimensões ......................................... 38 

3.2.6.5 Método Simplex ................................................................................................... 38 

3.2.7 Problemas de transporte............................................................................................ 41 

3.3 Geoprocessamento .......................................................................................................... 44 

3.3.1 Definição de Geoprocessamento .............................................................................. 45 

3.3.2 Importância do Geoprocessamento .......................................................................... 46 

3.3.3 História do Pensamento Geográfico e do Geoprocessamento .................................. 47 

3.3.4 Sistemas de Informação Geográfico - SIG ............................................................... 49 

3.4 Viabilidade Econômica .................................................................................................. 54 

3.4.1 Definição e importância da Viabilidade Econômica ................................................ 54 

3.4.2 Etapas de um estudo de Viabilidade Econômica ...................................................... 55 

3.4.3 Critérios de um estudo de Viabilidade Econômica .................................................. 58 

3.4.3.1 Valor Presente ou Valor Presente Líquido ........................................................... 58 

3.4.3.2 Período de Recuperação de Capital ou Payback .................................................. 59 

3.4.3.3 Taxa Interna de Retorno ou Taxa de Retorno....................................................... 60 

4 METODOLOGIA ........................................................................................................... 62 



 

 

4.1 Definição do problema em questão ............................................................................... 62 

4.2 Coleta, armazenamento e implementação de dados .................................................... 63 

4.3 Formulação de um modelo matemático para representar o problema ..................... 64 

4.4 Desenvolvimento de um modelo computacional para derivar as soluções ................ 65 

4.5 Modelagem de testes e implementação ......................................................................... 65 

4.6 Análise e uso integrado dos dados ................................................................................. 66 

5 DESENVOLVIMENTO ................................................................................................. 67 

5.1 Definição do problema e coleta de dados...................................................................... 67 

5.2 Definição de diferentes cenários de localização das ETAs via Sistema de Informação 

Geográfico ............................................................................................................................... 68 

5.3 Análise da economia gerada pelos cenários de produção de água e localização das 

ETAs via modelagem e otimização de rotas ......................................................................... 74 

6 RESULTADOS ............................................................................................................... 81 

7 CONCLUSÃO ................................................................................................................. 90 

REFERÊNCIAS BIBLIOGRÁFICAS ................................................................................. 92 

ANEXO A – CÓDIGO PARA RESOLUÇÃO DO MODELO DE PROGRAMAÇÃO 

LINEAR ................................................................................................................................... 98 

ANEXO B – CÓDIGO PARA EXPORTAR MATRIZES ............................................... 101 

ANEXO C – PASSO A PASSO DAS FERRAMENTAS WEIGHTED OVERLAY E GENERATE O/D 

MATRIX .............................................................................................................................. 102 

 



11 

 

1 INTRODUÇÃO 

 

A água é uma necessidade básica de qualquer ser vivo e possui uma relação estreita 

com a vida em si. Essa substância corresponde a 70% do peso corporal humano e é 

responsável pela manutenção de funções vitais do corpo. No entanto, apesar da dependência 

estabelecida entre a água e a vida, é sabido que a característica altamente solvente da água 

torna fácil a associação desse elemento com muitos outros, que, muitas vezes, podem ser 

nocivos aos seres vivos que a utilizam (MARIN-MORALES, 2016). 

Corpos hídricos, principalmente os superficiais, estão constantemente sujeitos a 

descargas químicas e orgânicas e podem vir a ser meio de veiculação de doenças ao exporem 

humanos e animais a compostos ou patógenos. Em momentos de seca, a poluição das águas 

fica ainda mais severa pela redução do volume de água e consequente concentração de 

poluentes. Por outro lado, constantemente atribui-se a contaminação de corpos d’água às 

chuvas intensas, que carregam lixo, fertilizantes, agrotóxicos e diversas outras substâncias 

poluentes para o leito dos rios. Sabe-se também que ambos eventos são cada vez mais 

frequentes em um contexto de aquecimento global (MARIN-MORALES, 2016). 

Considerando essa gradual degradação dos corpos hídricos, o saneamento básico surge 

como a solução para um fornecimento de água de qualidade à população, estando diretamente 

relacionado a redução de doenças, melhora da saúde, valorização econômica, conservação 

ambiental e aumento da produtividade humana (MELO, 2020; FERREIRA; GARCIA, 2017). 

Segundo a Organização das Nações Unidas, a cada dólar investido em saneamento básico 

economiza-se 4,3 dólares em saúde pública (UN, 2014). Além disso, há uma clara relação 

entre a melhora da infraestrutura de saneamento básico e a redução dos índices de mortalidade 

em países em desenvolvimento (SOARES et al, 2002). Nesse sentido, é fundamental que a 

água de abastecimento humano receba tratamento adequado. 

Por todos esses motivos que tornam o acesso a água um direito humano fundamental, 

a questão do saneamento foi estabelecida como o 6º objetivo da agenda 2030 do 

desenvolvimento sustentável (ODS), que enfatiza a importância do acesso a água tratada para 

todos. No que diz respeito ao tratamento de água, a ODS ainda postula: 

“Objetivo 6: Assegurar a disponibilidade e gestão sustentável da água e 

saneamento para todas e todos 

6.1 Até 2030, alcançar o acesso universal e equitativo a água potável e 

segura para todos (...) 

6.3 Até 2030, melhorar a qualidade da água, reduzindo a poluição, 

eliminando despejo e minimizando a liberação de produtos químicos e materiais 
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perigosos, reduzindo à metade a proporção de águas residuais não tratadas e 

aumentando substancialmente a reciclagem e reutilização segura globalmente 

6.4 Até 2030, aumentar substancialmente a eficiência do uso da água em 

todos os setores e assegurar retiradas sustentáveis e o abastecimento de água doce 

para enfrentar a escassez de água, e reduzir substancialmente o número de pessoas 

que sofrem com a escassez de água (...)” (Nações Unidas Brasil, 2018). 

 

O saneamento tem por fim essencialmente a preservação da saúde humana, e, por esse 

motivo, é uma responsabilidade pública. Práticas de saneamento básico são relatadas já no 

ano 691 a.C. (mesmo que de forma rudimentar) e no século IX as técnicas começam a tomar 

os moldes modernos e serem regulamentadas por lei (AZEVEDO NETTO; FERNÁNDEZ, 

2018; RINGEN, 1979). No Brasil, o Plano Nacional de Saneamento - PLANASA foi 

instituído em 1971 e trouxe avanços no setor, mas também contribuiu com o aumento da 

desigualdade e exclusão social no país ao eleger áreas de interesse para implantação das obras 

(RUBINGER, 2008; REZENDE; HELLER, 2002). As regiões mais desenvolvidas do 

território (Sul, Sudeste e Centro-Oeste) receberam investimentos sanitários mais robustos 

enquanto as regiões Norte e Nordeste sofrem até hoje com abastecimento precário e falta de 

tratamento de água e efluentes, sendo essas, respectivamente, as regiões menos acometidas 

por abastecimento de água no país (BRASIL, 2019).  

No Nordeste especificamente, 30% da população sofre com falta de abastecimento de 

água tratada e os índices de incidência de parasitoides, gastroenterites e doenças intestinais 

atinge níveis alarmantes, estando associados inclusive com índices mais altos de mortalidade 

infantil (FONSECA et al., 2010; BRASIL, 2016; LINS, 2019). Cidades nordestinas que 

evoluíram no acesso a água tratada reduziram em até 32% a mortalidade infantil relacionada 

ao saneamento entre 1991 e 2000 (SOUSA; LEITE FILHO, 2008). 

Portanto, apesar da importância e maturidade do tema, é notório que muitas regiões 

ainda sofrem com a falta de infraestrutura sanitária por questões burocráticas, administrativas, 

políticas e principalmente por falta de planejamento e investimento. Nesse sentido, 

ferramentas tecnológicas como a modelagem computacional e o Sistema de Informação 

Geográfico surgem como uma forma de incentivar a melhoria do sistema de abastecimento de 

água em regiões vulneráveis através da sugestão de métodos de gestão da água 

economicamente viáveis, visando o aumento da qualidade e abrangência desses sistemas da 

forma mais eficiente possível.  
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2 OBJETIVO 

 

O presente Trabalho de Conclusão de Curso objetiva encontrar a melhor localização 

de uma Estação de Tratamento de Água - ETA no Estado do Ceará, um dos maiores estados 

do Nordeste brasileiro, analisando a viabilidade econômico-financeira da construção de 

diferentes novas ETAs.  

Para tanto, os objetivos gerais e específicos do trabalho em questão são descritos a 

seguir. 

 

2.1 Objetivo Geral  

 

Desenvolver um modelo de otimização de rotas e localização de uma ETA via 

modelagem de rotas e Sistema de Informação Geográfica - GIS para processamento e 

integração dos dados geográficos/de localização e, também, para compreensão intuitiva deles. 

 

2.2 Objetivos Específicos 

 

Os objetivos específicos do estudo em questão são, então: 

a) Compreender a situação e as principais consequências da produção, consumo e 

distribuição de água;  

b) Compreender a situação da seca no Nordeste brasileiro e a principal operação e ação 

governamental tomada para mitigar os impactos negativos causados pelo estresse 

hídrico, a Operação Carro-Pipa; 

c) Analisar o cenário atual de distribuição de água do Estado do Ceará; 

d) Construir diferentes cenários de localização de estações de tratamento de água - 

ETAs no Ceará através de sistemas de informações geográficas; 

e) Analisar a economia gerada pelos cenários construídos perante o principal custo na 

distribuição de água dos carros-pipas - distância - através da modelagem e 

otimização de rotas; 

f) Analisar a viabilidade econômica através de indicadores financeiros para a escolha 

dos melhores cenários de localização de ETAs no Estado do Ceará.  
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REVISÃO BIBLIOGRÁFICA 

 

Para o presente, os temas revisados na literatura acadêmica foram: (i) a água e o 

Nordeste; (ii) pesquisa operacional; (iii) geoprocessamento; e, (iv) viabilidade econômica.  

 

2.3 A água e o Nordeste 

 

“A água é um recurso natural essencial, seja como componente de seres vivos ou 

como meio de vida de várias espécies vegetais e animais, seja como elemento representativo 

de valores sociais e culturais, seja como fator de produção de bens de consumo e produtos 

agrícolas” (BASSOI, 2014). A água é fundamental para qualquer organismo vivo, como parte 

constituinte inorgânica ou como fator de consumo nas atividades humanas, a água é 

indispensável para a sobrevivência humana, animal, da fauna e da flora.   

"O ciclo da água é muito importante para todas e todos, seja para o consumo diário, 

seja para o abastecimento nas residências, a geração de energia elétrica, a produção de 

alimentos e muito mais" (ANA, 2020). Como um recurso do consumo brasileiro das 

atividades agrícolas e humanas, são consumidos, em média, 246 m3/habitante/ano. 

Globalmente, a agricultura consome cerca de 69% da água captada, a indústria utiliza 23% e 

os restantes 8% destinam-se ao consumo doméstico; no Brasil, esses percentuais são 70%, 

20% e 10%, respectivamente (BASSOI, 2014).  

A água é a substância mais abundante no planeta e encontra-se distribuída nos estados 

líquidos, sólido e gasoso pelos oceanos, rios e lagos, nas calotas polares e geleiras, no ar e no 

subsolo. Assim, a parcela disponibilizada nas fontes de onde são retiradas a maior parte desse 

recurso abundante, porém limitado, é a menor de todas e, infelizmente, também é o local onde 

são lançados os resíduos. 

 

"A água dos oceanos representa cerca de 96% do total disponível na Terra. 

Se somado às águas salgadas subterrâneas e à de lagos de água salgada, totaliza 98% 

da água do planeta, a princípio, indisponível para diversos usos. Da água doce 

restante, aproximadamente 2% do total, cerca de 70% estão na forma de gelo e na 

atmosfera e 30% está distribuída nas águas subterrâneas, a maior parte em grandes 

profundidades e, portanto, inacessíveis, e nas águas superficiais. Isso significa que o 

estoque de água doce do planeta e que, de alguma forma, pode estar disponível para 

o uso do homem é de cerca de 0,3%, ou 4 milhões de km3 e se encontra 

principalmente no solo" (BASSOI, 2014, p. 193-214). 
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Além disso, apesar da abundância das fontes de água no mundo, esse recurso é mal 

distribuído na superfície do planeta Terra. Um exemplo é o Brasil com a maior 

disponibilidade hídrica do planeta e, mesmo assim, enfrentando diferentes desafios frente a 

essa má distribuição. Com cerca de 13,8% do deflúvio médio mundial (5.744 km3/ano), 

68,5% dos recursos hídricos estão localizados na região Norte, onde habitam cerca de 7% da 

população brasileira; 6% estão localizados na região Sudeste, onde 43% da população habita e 

o maior parque industrial da América Latina está instalado; e, 3% estão localizados na região 

Nordeste, onde vivem 29% da população (BASSOI, 2014, p.193-214).  

Segundo Lineu Bassoi (2014), o conceito de poluição das águas deve estar associado à 

sua qualidade e deve ser entendido como “qualquer alteração das suas características físicas, 

químicas ou biológicas que prejudique um ou mais de seus usos preestabelecidos” (BASSOI, 

2014, p.193-214). O termo “usos preestabelecidos” deve‐se ao fato de que "toda a água 

disponível, para ser utilizada, deve estar associada a usos atuais ou futuros, os quais deverão 

estar compatíveis com a sua qualidade, também atual ou futura" (BASSOI, 2014, p.193-214). 

A Lei de Política Nacional do Meio Ambiente (Lei Nº 6.938, de 31 de agosto de 1981) define 

como poluição:  

"(...) a degradação da qualidade ambiental resultante de atividades que 

direta ou indiretamente: a) Prejudiquem a saúde, a segurança e o bem-estar da 

população; b) criem condições adversas às atividades sociais e econômicas; c) 

afetem desfavoravelmente a biota. d) afetem as condições estéticas ou sanitárias do 

Meio Ambiente; e) lancem matéria ou energia em desacordo com os padrões 

ambientais estabelecidos (art.3o, III)" (Lei de Política Nacional do Meio Ambiente, 

1981, p.1). 

 

As atividades humanas são uma das principais causas da poluição das águas e dois 

exemplos disso são o lançamento de efluentes domésticos e industriais sem tratamento prévio 

nas fontes. Outras causas, que também podem elevar a concentração de alguns compostos em 

determinado ecossistema, são condições geoquímicas específicas, como chuvas e atividade 

vulcânica (SANTOS et al., 2012). Para Bassoi (2014), as fontes de poluição das águas podem 

ser agrupadas, de acordo com o tipo de uso e ocupação no solo, em quatro grandes grupos: (i) 

poluição natural; (ii) poluição devido aos esgotos domésticos; (iii) poluição devida aos 

efluentes industriais; e, (iv) poluição devida à drenagem de áreas agrícolas e urbanas. Outra 

classificação utilizada, conforme Sônia et al. (2012), é a divisão da poluição de acordo com 

seu tipo: (i) poluição térmica, (ii) poluição sedimentar, (iii) poluição biológica, (iv) poluição 

radioativa, (v) poluição química.  
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Por outro lado, o campo da engenharia sanitária evoluiu rapidamente no 

desenvolvimento de métodos para o tratamento de águas residuárias; essa evolução ocorreu 

principalmente das exigências governamentais e sociais. Para tanto, o aumento da população 

aumentou a pressão sobre as limitadas fontes superficiais de água de elevada qualidade e sua 

contaminação com resíduos urbanos, agrícolas e industriais levando à deterioração da 

qualidade da água em muitas outras fontes. Ao mesmo tempo, as normas de qualidade da água 

tornaram-se mais rigorosas, os métodos analíticos para a detecção de contaminantes tornaram-

se mais apurados e o público tornou-se mais exigente quanto à qualidade da água (HOWE et 

al., 2016; BASSOI, 2014).  

De acordo com Bassoi (2014), um sistema de tratamento de água é constituído por 

uma série de operações e processos para remoção das substâncias indesejáveis da água ou 

para transformação em formas aceitáveis, em que os processos de tratamento podem ser 

diferenciados entre processos físicos, químicos e biológicos. Para Howe et al. (2016, p.1-2), 

define-se tratamento de água como: 

 "o processamento desta para atingir uma qualidade que atenda os objetivos 

ou padrões específicos estabelecidos pelo usuário final ou por uma comunidade por 

meio de suas agências reguladoras; onde metas e padrões podem incluir as 

exigências dos órgãos reguladores, requisitos adicionais estabelecidos por uma 

comunidade local e requisitos associados a processos industriais específicos" 

(HOWE et al., 2016, p.1-2). 

 

No Brasil, segundo Parkesian (1998) e Cordeiro (2001), existem mais de 7.500 

estações de tratamento de água de ciclo completo ou convencional, as quais variam em 

tamanho e capacidade de tratamento, constituindo-se talvez na maior indústria em relação ao 

número de pessoas envolvidas direta ou indiretamente em seu sistema produtivo.  

Contudo, o Brasil produz 12,6 bilhões de metros cúbicos de água anualmente para 

sistemas de abastecimento, em que apenas 7,6 bilhões de metros cúbicos são faturados. 

Assim, 4,9 bilhões de metros cúbicos de água são desperdiçados entre as estações de 

tratamento e a torneira do consumidor final por diversos problemas como as perdas 

operacionais, sejam elas de faturamento ou física (SILVA, 2007 apud BIO, 2006).  

A Estação de Tratamento de Água - ETA é composta por unidades fundamentais a fim 

de que a qualidade da água de abastecimento seja compatível para seu uso final. Para tanto, 

para transformar água bruta em água tratada, conforme a legislação vigente, são utilizados 

processos e operações que se interligam de maneira semelhante à técnica produtiva industrial. 

Assim, o projeto e as condições operacionais podem levar a desperdícios e perdas de água no 
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processo, perdas de produtos químicos, perdas de energia elétrica, além de provocar impactos 

ambientais (SILVA, 2007). 

. Portanto, para garantir e manter um fornecimento adequado de água, a maior parte 

das fontes de água requer não só algum tipo de tratamento antes do consumo humano, mas um 

bom gerenciamento dos processos e recursos relacionados a ele, como os aspectos custo, 

tempo e qualidade (SILVA, 2007). 

Segundo a AQUASTAT (2010), o consumo global de água doce/potável aumentou 

seis vezes nos últimos 100 anos e continua a crescer a uma taxa de aproximadamente 1% ao 

ano desde a década de 80. Apesar da taxa de aumento de consumo ter diminuído nos países 

pertencentes aos Estados Membros da Organização para Cooperação e Desenvolvimento - 

OCDE, onde as taxas per capita tendem a serem as mais altas do mundo, o consumo em 

países de economia emergentes continua a crescer, assim como em países de baixa ou média 

renda (RITCHIE; ROSER, 2018). Para a Organização das Nações Unidas para a Educação, 

Ciência e Cultura, em seu relatório de Desenvolvimento Mundial da Água (2021), esse 

crescimento pode ser explicado pelo crescimento da população, ao desenvolvimento da 

economia e às mudanças de padrões de consumo. 

 

 

*Evaporação de lagos artificiais 

Figura 1: Captação Global de Água 

Fonte: AQUASTAT (2010) 
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Segundo a Organização de Alimentos e Agricultura das Nações Unidas (2011a), ou 

Food and Agriculture Organization of the United Nations - FAO em inglês, a agricultura é 

responsável por 69% das captações globais de água, em que seu uso é direcionado, 

principalmente, a irrigação, mas também a pecuária e a aquicultura. Esse valor de captação 

hídrica destinada a agricultura pode atingir porcentagens superiores a 90% em alguns países 

em desenvolvimento. A indústria é responsável, incluindo energia e geração de energia, por 

19% e os municípios são responsáveis pelo restante das captações, 12%. As projeções das 

tendências de uso da água no futuro são variadas nos estudos acadêmicos como, por exemplo: 

o 2030 Water Resources Group (2009) concluiu que o mundo enfrentaria um déficit hídrico 

global de 40% até 2030 em um cenário usual de negócios. Por sua vez, a Organização para a 

Cooperação e Desenvolvimento Econômico - OCDE (2012) projetou que a demanda global 

de água aumentaria 55% entre 2000 e 2050. Burek et al. (2016) ainda estimaram que o uso 

global de água provavelmente continuaria a crescer a uma taxa anual de cerca de 1%, 

resultando em um aumento de 20 a 30% acima do nível atual de uso de água até 2050.  

Na Figura 2 abaixo do relatório de Desenvolvimento Mundial da Água das Nações 

Unidas (2021), é possível visualizar como o estresse de água, isto é, a medida do uso de água 

doce em função do abastecimento disponível, afeta diferentes partes do mundo, sendo na 

maioria das vezes um fenômeno sazonal e não anual. Mais de dois bilhões de pessoas vivem 

em países com estresse hídrico (NAÇÕES UNIDAS, 2018). Estima-se que quatro bilhões de 

pessoas vivam em áreas que sofrem de grave escassez física de água por pelo menos um mês 

por ano (MEKONNEN; HOEKSTRA, 2016). Deve-se notar também o número de pessoas 

enfrentando a escassez da água "econômica": 1,6 bilhão de pessoas que carecem da 

infraestrutura necessária para ter acesso a essa água, embora a água possa estar fisicamente 

disponível (Avaliação Abrangente da Gestão da Água na Agricultura, 2007). Contudo, ainda 

existe a questão da mudança climática. A mudança climática provavelmente aumentará a 

variabilidade sazonal, criando um abastecimento de água mais errático e incerto, exacerbando 

os problemas em áreas já com escassez de água e potencialmente gerando estresse hídrico em 

locais onde ainda não foi um fenômeno recorrente (Organização das Nações Unidas para a 

Educação, Ciência e Cultura, 2021).  
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Figura 2: Estresse Hídrico Anual 

Fonte: Organização das Nações Unidas para a Educação, Ciência e Cultura (2021) 

 

Conhecido como um recurso de sustentação da economia e do desenvolvimento 

sustentável, é de extrema importância o reconhecimento, a mensuração e a expressão do valor 

da água, e também sua incorporação na tomada de decisão das organizações públicas e não 

públicas. A valorização da água, pelo menos em um nível fundamental, está implícita na 

maioria das decisões de gestão de recursos hídricos e se conecta, por exemplo, nas estruturas 

de direitos humanos, com a Agenda 2030 para o Desenvolvimento Sustentável e seus pilares e 

com a Gestão Integrada de Recursos Hídricos - GIRH, entre outros. Entende-se valoração, ou 

valuation em inglês, como o processo de atribuir valor a algo, seja o autor uma pessoa ou uma 

entidade. No contexto de recursos naturais, entende-se o termo valor de três perspectivas: (i) 

valor de troca como o preço de mercado; (ii) utilidade como o valor de uso do recurso; e, (iii) 

importância como a apreciação ou valor emocional atribuído a um determinado bem ou 

serviço (Organização das Nações Unidas para a Educação, Ciência e Cultura, 2021).  

Alguns exemplos de métodos para o cálculo do valor da água, conforme as Nações 

Unidas, são: (i) valor residual; (ii) modelos de programação matemática; (iii) custo de 

reposição ou valor de reposição; (iv) avaliação de contigência/contingente; (v) funções de 

demanda; (vi) negociações de direitos hídricos; e, (vii) footprint hídrica.  
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“Valor residual: estimativa de mudança no lucro líquido; isto é, a diferença 

(o residual) entre o valor da produção e os custos de todos os insumos não 

relacionados à água para a produção (...) Modelos de programação matemática: (...) 

objetiva maximizar o valor da produção, sujeito a insumos de produção, como 

abastecimento de água e restrições institucionais e comportamentais; as abordagens 

econômicas podem usar programação linear ou simulação para comparar valores 

marginais de água entre os setores (por exemplo, Renzetti e Dupont, 2003) (...) 

Custo ou valor de reposição: refere-se ao valor que uma entidade teria que pagar 

para substituir um ativo no momento presente, de acordo com seu valor atual (...) 

Avaliação de contingência: avalia quanto os indivíduos estariam dispostos a pagar 

pelo item em questão; o método é especialmente útil para determinar o valor de bens 

e serviços ecossistêmicos que não têm preços de mercado; ou seja, avalia a demanda 

de água do consumidor, perguntando aos consumidores quanto eles estariam 

dispostos a pagar pela água (...) Funções de demanda: estudos da curva de demanda 

das vendas reais de água (preferência revelada) ou do uso da abordagem de 

avaliação contingente (preferência declarada), envolvendo a  análise econométrica 

para medir o valor econômico total (...) Negociações de direitos hídricos: tentativa 

de capturar mercados na derivação do valor da água (...) Footprint hídrica: é um 

indicador de uso de água doce que analisa o uso de água direto e indireto de um 

consumidor ou produtor, e pode ser calculado para um produto específico, para 

qualquer grupo bem definido de consumidores ou produtores” (Relatório de 

Desenvolvimento Mundial da Água das Nações Unidas, 2021, p.26). 

 

Se os níveis de estresse hídrico (FAO, 2018b) não são analisados em nível nacional, 

mas sim desagregados em nível de bacias hidrográficas ou territórios específicos, são 

identificados, na América Latina e no Caribe, cenários de alta pressão hídrica em áreas mais 

populosas e também centros de atividade econômica. Os casos mais relevantes são os do Vale 

Central no Chile, a região de Cuyo na Argentina, o litoral do Peru e sul do Equador, os Vales 

Cauca e Magdalena na Colômbia, o Altiplano boliviano, o Nordeste brasileiro, a costa do 

Pacífico da América Central, e grande parte do norte do México (FAO, 2016). Todas as áreas 

mencionadas apresentam níveis de estresse hídrico acima de 80%, um nível considerado 

extremamente alto, por períodos que variam de 3 a 12 meses por ano (MEKONNEN et al., 

2015).  

De acordo com a Agência Nacional de Águas e Saneamento Básico - ANA em seu 

relatório de Conjuntura Recursos Hídricos Brasil (2020), as regiões mais críticas, frente ao 

crescimento da demanda hídrica, no Brasil são o Sudeste, Sul e Nordeste. No Sudeste, se 

destaca o consumo da água para o abastecimento humano, a irrigação e a indústria; já no Sul, 

é expressiva a irrigação de grandes lavouras de arroz pelo método de inundação; e, no 

Nordeste, a demanda é considerável quando comparada à sua baixa disponibilidade hídrica. 

Dos 5.570 municípios brasileiros, 49,2% decretaram Situação de Emergência - SE ou Estado 

de Calamidade Pública - ECP devido às cheias pelo menos uma vez entre os anos de 2003 a 

2019, e, cerca de 88% dos municípios localizam-se nas regiões Nordeste, Sul e Sudeste.  
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Segurança Hídrica consiste na disponibilidade hídrica em quantidade e qualidade 

suficientes para o atendimento às necessidades humanas, à prática das atividades econômicas 

e à conservação dos ecossistemas aquáticos, acompanhada de um nível aceitável de risco 

relacionado às secas e cheias. Em 2019, mais de dois milhões de pessoas foram afetadas por 

alagamentos, enxurradas ou inundações no Brasil. Além disso, cerca de 22 milhões de pessoas 

foram afetadas por secas e estiagens e quase 94% das pessoas afetadas por secas em 2019 

vivem na região Nordeste, contabilizando 80% dos registros do país. Estima-se ainda que 60,9 

milhões de brasileiros vivam em cidades com risco hídrico e que há necessidade de R$ 27,5 

bilhões em investimentos para segurança hídrica no Brasil até 2035 (ANA, 2020).  

No contexto do estudo Atlas Águas da ANA (2020), as cidades brasileiras foram 

classificadas quanto ao grau de vulnerabilidade dos mananciais para abastecimento urbano ao 

considerar o grau de resiliência, a relação demanda x disponibilidade hídrica e o porte dos 

mananciais. Observa-se que 43% das sedes municipais apresentam um certo grau de 

vulnerabilidade, sendo que 5% são caracterizadas como alta, 12% média e 26% baixa. Em 

relação à população urbana, apenas 3% mostram alta vulnerabilidade, 13% média e 20% 

apresentam baixa vulnerabilidade, resultando em 36% da população urbana brasileira com 

algum grau de vulnerabilidade. A região Nordeste do Brasil é a que mostra o maior percentual 

de sedes e população com algum grau de vulnerabilidade, sendo 68% e 69%, respectivamente. 

A baixa disponibilidade hídrica combinada com a falta de resiliência hídrica, principalmente 

no polígono do Semiárido e faixa costeira, contribui para o resultado apresentado. 

Alguns dos principais obstáculos para processos eficazes de alocação da água estão 

relacionados à regulamentação deficiente, falta de incentivos e/ou falta de investimento. Para 

tanto, esses fatores refletem o baixo valor atribuído aos recursos hídricos da região como, por 

exemplo, as proporções de águas residuais devidamente tratadas em 2018 foram de 22% na 

Argentina, 23% na Colômbia, 34% no Brasil, 39% no Peru, 43% no Equador, 51% no México 

e 72% no Chile (Departamento das Nações Unidas para Assuntos Econômicos e Sociais - 

UNDESA, 2012). Globalmente, cerca de 80% de todas as águas residuais, industriais e 

municipais são lançadas no meio ambiente sem qualquer tratamento prévio, com efeitos 

prejudiciais à saúde humana e aos ecossistemas. Essa proporção é muito maior nos países 

menos desenvolvidos, onde há grande falta de instalações de saneamento e tratamento de 

águas residuais (Programa Mundial de Avaliação da Água - WWAP, 2017). 

Ademais, a higiene das mãos é de extrema importância para prevenir a propagação de 

COVID-19 (Organização Mundial da Saúde - OMS, 2020a). Contudo, mais de três bilhões de 
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pessoas e dois em cada cinco centros de saúde não possuem acesso adequado a instalações de 

higiene das mãos. O acesso inadequado às instalações de higiene básica aumenta o risco de 

propagação de COVID-19 e outras doenças infecciosas. Os impactos sociais, econômicos e 

sanitários da pandemia do coronavírus, o aumento na compra de produtos de higiene para 

mitigar a propagação do vírus e o impacto ambiental desses produtos, especialmente os 

plásticos, transformam positivamente a visibilidade do valor da água, saneamento e higiene 

(Organização das Nações Unidas para a Educação, Ciência e Cultura, 2021). Portanto, a 

COVID-19 revela o papel crítico dos governos locais e operadores de água e saneamento para 

preservação e manutenção dos serviços hídricos, de saneamento e de higiene durante as 

pandemias (Grupo das Nações Unidas para o Desenvolvimento - UNSDG, 2020). De acordo 

com a Global Water Operators Partnership Alliance - GWOPA (2020), os serviços públicos 

devem trabalhar em estreita colaboração com as autoridades locais de saúde e outros órgãos 

relevantes para maximizar o acesso à água potável segura e ao saneamento, especialmente 

para as comunidades vulneráveis, para garantir a continuidade do serviço de água, do 

tratamento adequado, da acessibilidade para todos e da acessibilidade econômica. 

Portanto, diferentes ações precisam ser tomadas para mitigar os impactos negativos 

causados pelo estresse hídrico, sejam eles governamentais ou não-governamentais, 

emergenciais ou não-emergenciais. Um exemplo são as Operações Carro-Pipa - OCP. 

Conhecido politicamente como um abastecimento emergencial ou uma medida reativa, o 

número de municípios atendidos pela Operação Carro-Pipa do Governo Federal, em 2019, 

correspondeu a 667 municípios, majoritariamente rurais, com desembolso de cerca de 640 

milhões de reais (ANA, 2020). Para tanto, adota-se a OCP, em situações de crise, como uma 

medida de redução do abastecimento e estresse hídrico a fim de evitar o esgotamento dos 

mananciais, através da contratação de caminhões pipa e transporte da água. Na Tabela 1 

abaixo, é possível analisar os dados de atendimento, operação e investimento da OCP ao 

longo dos anos, provenientes do Centro Nacional de Gerenciamento de Riscos e Desastres - 

CENAD do Ministério do Desenvolvimento Regional.  

 

Tabela 1: Dados sobre a Operação Carro-Pipa do Governo Federal 

 2017 2018 2019 

Municípios atendidos 848 718 667 

Carros-pipa em operação 6.683 5.165 4.712 



23 

 

 2017 2018 2019 

População atendida (em milhões) 3,25 2,41 2,24 

Valor Total Descentralizado (em R$ milhões) 872,24 686,43 640,50 

 

Fonte: CENAD  

 

2.4 Pesquisa Operacional 

 

Uma das áreas predominantes da Pesquisa Operacional é o problema de transporte, 

apresentando amplas aplicações em controle de estoque, rede de comunicação, planejamento 

de produção, programação, alocação pessoal e assim por diante. Os problemas de transporte 

desempenham um papel importante na logística e gestão da cadeia de abastecimento para 

reduzir custos e melhorando o serviço. Como e quando enviar os produtos aos consumidores 

nas quantidades o que eles desejam, ou precisam, de maneira econômica torna-se mais 

desafiador. Assim, os modelos de transporte fornecem uma poderosa estrutura para enfrentar 

este desafio (ANURADHA, 2016). 

Para tanto, nesta seção serão descritos a história, definição, etapas, modelos e técnicas 

da Pesquisa Operacional para então descrição de um problema particular de transportes. 

 

3.2.1 História da Pesquisa Operacional 

 

As origens da Pesquisa Operacional - PO - remontam a décadas de história, nas quais 

há considerável contribuições científicas de 1564 a 1935, que influenciaram o posterior 

desenvolvimento da pesquisa operacional (HILLIER; LIEBERMAN, 2013). Iniciada nos 

primórdios da Segunda Guerra Mundial, a pesquisa operacional foi uma das primeiras 

tentativas, se não a primeira, de uma abordagem científica da gestão das organizações.  

"Em razão da guerra, havia necessidade premente de alocar de forma 

eficiente os escassos recursos para as diversas operações militares. (...) convocaram 

grande número de cientistas para lidar com este e outros problemas táticos e 

estratégicos. Na prática lhes foi solicitada a realização de pesquisas sobre 

operações" (HILLIER; LIEBERMAN, 2013, p.1).  

 

Para tanto, como o próprio nome indica, a pesquisa operacional envolve "pesquisa 

sobre operações". No início dos anos 60, a modelagem por pesquisa operacional já havia sido 
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aplicada aos processos básicos das organizações, como na gestão de inventários e na 

programação e alocação de recursos (GERSHEFSKI, 1970). 

No Brasil, a pesquisa operacional teve início na década de 1960. O primeiro simpósio 

brasileiro de pesquisa operacional foi realizado em 1968 no Instituto Tecnológico de 

Aeronáutica - ITA, em São José dos Campos, São Paulo. Em seguida, foi criada a Sociedade 

Brasileira de Pesquisa Operacional - SOBRAPO. Há mais de 25 anos, a SOBRAPO realiza 

congressos científicos anuais, nacionais e/ou regionais, e é responsável pelo periódico 

científico Pesquisa Operacional há mais de 25 anos (BATALHA et al., 2008).  

 

3.2.2 Definição de Pesquisa Operacional 

 

A Pesquisa Operacional é um método científico de fornecer aos departamentos 

executivos uma base quantitativa para as decisões relativas às operações sob seu controle 

(KITTEL, 1947; C. GOODEVE, 1948). É a análise matemática ou científica da eficiência 

sistemática e do desempenho da mão de obra, maquinários, equipamentos e políticas usadas 

em uma operação governamental, militar (American Heritage Dictionary of the English 

Language 921, 1976.). Para Ackoff e Sasinieni (1968), pesquisa operacional é a aplicação do 

método científico, por equipes multidisciplinares, a problemas envolvendo o controle de 

sistemas organizados de forma a fornecer soluções que melhor interessam a determinada 

organização. Pesquisa Operacional, portanto, é a ciência da tomada de decisões (ASSAD; 

GASS, 2011). 

Segundo Hillier e Lieberman (2013), a pesquisa operacional é aplicada a problemas 

que compreendem a condução e coordenação das operações, i.e. das atividades, em uma 

organização de natureza essencialmente secundária. A natureza da organização não importa 

para aplicação de um estudo de pesquisa operacional. De fato, a possibilidade de aplicações é 

excepcionalmente grande, em que a PO já foi e pode ser aplicada em diferentes áreas como 

manufatura, transportes, construção, telecomunicações, planejamento financeiro, assistência 

médica, militar, serviços públicos e outras (HILLIER; LIEBERMAN, 2013). Assim, a 

SOBRAPO define pesquisa operacional como uma área de conhecimento que estuda, 

desenvolve e aplica métodos analíticos avançados para auxiliar na tomada de melhores 

decisões nas mais diversas áreas de atuação humana (SOBRAPO, 1969). 

Para Michael Pidd (1999), a essência da pesquisa operacional pode ser resumida em 

apenas uma palavra: modelagem. A modelagem, para Michael Pidd, é um verbo ou uma 
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atividade, e não um substantivo ou um sujeito. Contudo, o modelo "é uma representação 

externa e explícita de uma parte da realidade vista pelas pessoas que desejam usar esse 

modelo para entender, para mudar, para gerenciar e controlar essa parte da realidade de uma 

forma ou de outra" (PIDD, 1999, p.1-139).  Os modelos de PO, portanto, possuem dois 

principais usos: (i) explorar as possíveis consequências antes de ações e decisões serem 

tomadas; ou, (ii) fazer parte de um sistema computacional para suporte a decisões 

estratégicas. Hoje, a pesquisa operacional apresenta um grande potencial tanto às 

organizações quanto para a sociedade, que costuma-se dizer que ela é “uma solução à procura 

de um problema” (SELLITTO, 2000). 

Como é possível ver pelas diferentes definições acima, para definição de pesquisa 

operacional, não existe consenso na academia. Ou seja, não há consenso entre os autores e 

estudiosos da área de pesquisa operacional quanto à definição mais apropriada a ser atribuída 

a ela, ou mesmo se pode ser definida. Contudo, existem características em comum entre todas 

as definições como: aplicações de PO à problemas de condução e coordenação das operações 

ou atividades dentro de uma organização; amplitude de aplicações; abordagem do método 

científico; ponto de vista organizacional; busca da solução ótima; e, equipes 

multidisciplinares (GAVIRA, 2003). 

 

3.2.3 Etapas de um estudo de Pesquisa Operacional  

 

No seu guia de modelagem, Just Modeling Through: A Rough Guide to Modeling, 

Michal Pidd (1999) descreve seus seis princípios de modelagem: (i) modelo simples, pense 

complicado; (ii) seja parcimonioso, comece pequeno e adicione; (iii) dividir e conquistar, 

evitar mega-modelos; (iv) use metáforas, analogias e semelhanças; (v) não se apaixone por 

dados; (vi) a construção do modelo pode parecer confusa. 

Ademais, de acordo com Hillier e Lieberman (2013), uma forma de sintetizar as fases 

gerais da abordagem de modelagem e estudo da pesquisa operacional é:  

a) Definir o problema de interesse e coletar dados; 

b) Formular um modelo matemático para representação do problema; 

c) Desenvolver um procedimento computacional a fim de derivar soluções para o 

problema com base no modelo; 

d) Testar o modelo e aprimorá-lo conforme o necessário; 



26 

 

e) Preparar-se para a aplicação contínua do modelo conforme prescrito pela gerência;  

f) Implementar. 

 

A definição do problema e coleta de dados é a primeira fase para um estudo de 

pesquisa operacional. Estudar o sistema em questão e desenvolver um enunciado bem 

definido do problema a ser considerado é fundamental para o sucesso do projeto. "É difícil 

obter uma resposta 'correta' para um problema 'incorreto' " (HILLIER; LIEBERMAN, 2013, 

p.10). Ademais, a definição do problema é uma tarefa difícil de realizar quando envolve uma 

equipe de tomadores de decisão devido aos diferentes interesses e pontos de vista 

representados por cada membro do grupo (DAVID; COLIN; SUE, 1981). Para tanto, 

determinar os objetivos apropriados é um aspecto muito importante na definição de um 

problema (HILLIER; LIEBERMAN, 2013). 

As equipes de pesquisa operacional, em geral, investem um tempo considerável na 

coleta de dados relevantes sobre o problema em análise. Grande parte dos dados normalmente 

é necessária tanto para se obter o entendimento preciso sobre o problema como também para 

fornecer os dados necessários para o modelo matemático que será formulado.  

A próxima fase é preparar o problema para a análise, i.e. "formular esse problema de 

forma que seja conveniente para a análise" (HILLIER; LIEBERMAN, 2013, p.9). O modelo 

matemático construído é inestimável na abstração da essência da matéria da investigação, 

mostrando inter-relacionamentos e facilitando a análise. Para tanto, para eles, os modelos 

matemáticos também são representações idealizadas expressas com símbolos e expressões 

matemáticas.  

As vantagens de um modelo matemático, de acordo com Hillier e Lieberman (2013), 

são: (i) descrever um problema de forma muito mais concisa, tornando a estrutura geral do 

problema mais compreensível; (ii) relevar relacionamentos importante de causa-efeito; (iii) 

facilitar o tratamento do problema como um todo, considerando seus inter-relacionamentos de 

forma simultânea; e, por fim, (iv) formar uma ponte para o emprego de técnicas matemáticas 

e computadores potentes para analisar o problema. A pesquisa operacional e a computação 

digital/digitalização têm crescido lado a lado nos últimos 60 anos, com grandes quantidades 

históricas de capacidade de computação disponível sendo dedicadas à solução de programas 

lineares (BIXBY, 2002).  
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Contudo, há desvantagens no uso de modelos matemáticos. Para Hillier e Lieberman 

(2013), "ao se usar modelos matemáticos (...) se requerem aproximações e suposições 

simplificadas, caso se deseje que o modelo seja tratável". Para tanto, ao desenvolver e 

construir um modelo matemático do problema em questão, é eficiente iniciar por uma versão 

mais simples e, progressivamente, avançar para modelos mais elaborados que representam 

mais fielmente a complexidade do problema real. Esse processo é chamado de enriquecimento 

do modelo, em que o equilíbrio básico entre a precisão e a tratabilidade deve ser levado em 

consideração. 

Após a formulação de um modelo matemático, a próxima fase é desenvolver um 

procedimento para derivar soluções para o problema em questão. Herbert Simon, cientista e 

Prêmio Nobel em economia, institui o termo satisfacting, combinação das palavras inglês 

satisfactory e optimizing (satisfatório e otimização), e descreve a tendência dos 

administradores de procurar uma solução "suficientemente boa". Um dos objetivos da 

pesquisa operacional é buscar uma solução ótima. Contudo, Simon defende o emprego de 

uma abordagem mais pragmática. "Em vez de criar uma medida de desempenho global para 

conciliar de forma ótima conflitos entre vários objetivos desejáveis (...) Podem ser 

estabelecidos objetivos para se atingirem níveis mínimos de desempenho satisfatórios em 

diversas áreas, (...)" (HILLIER; LIEBERMAN, 2013, p.12). Portanto, para Simon, o objetivo 

de um estudo de PO deveria ser de conduzir o estudo de maneira otimizada, 

independentemente se isso envolve ou não descobrir uma solução ótima para o modelo. 

Consequentemente, uma solução ótima do modelo inicial construído para o problema 

real pode estar longe do ideal, de modo que se faz necessária uma análise adicional: a análise 

de pós-otimalidade. Denominada às vezes como análise e se, a análise, feita após encontrar-se 

a solução ótima, envolve responder perguntas sobre o que aconteceria à solução ótima se 

fossem elaboradas diferentes suposições sobre condições futuras. Em parte, a análise de pós-

otimalidade envolve conduzir uma análise de sensibilidade para estabelecer os parâmetros 

sensíveis, i.e. mais críticos, na determinação do problema. "Para um modelo matemático com 

valores especificados para todos os seus paradigmas, os parâmetros sensíveis do modelo são 

aqueles cujos valores não podem ser modificados sem se alterar a solução ótima" (HILLIER; 

LIEBERMAN, 2013, p.13).  

A próxima fase é testar o modelo. Desenvolver um modelo matemático de grandes 

dimensões é análogo, sob certos aspectos, a desenvolver um programa de computador muito 

extenso, i.e. ele "inevitavelmente conterá muitos bugs". Para tanto, de acordo com Hillier e 
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Lieberman (2013), o processo de teste e aperfeiçoamento do modelo, a depender da natureza 

do problema em questão e do modelo utilizado, é necessário, a fim de aumentar sua validade. 

Após a fase de validação, as fases de preparação para aplicação e implementação da 

modelagem se iniciam. Se o modelo for usado repetidamente, a próxima etapa é instalar um 

sistema bem documentado para sua aplicação. Esse sistema geralmente se baseia em 

computadores e inclui o próprio modelo, o procedimento de solução e os procedimentos 

operacionais para implementação. Alguns exemplos de sistema com aplicação de um estudo 

de pesquisa operacional são: sistemas de informação gerenciais, como MRP e MRP II, e 

sistema de apoio à decisão. A última fase de um estudo de PO é implementar esse sistema 

conforme prescrito pela administração; "essa é uma fase crítica, pois é aqui, e somente aqui, 

que os frutos do estudo serão colhidos" pela organização (HILLIER; LIEBERMAN, 2013, 

p.16).  

Uma outra forma de sintetizar as fases gerais de um estudo de pesquisa operacional é 

proposto por Moreira et al. (2004). De forma ampla, esse processo de solução de um 

problema é representado pela Figura 3 abaixo.  

 

 

Figura 3: Processo de Solução de um Problema de PO 

Fonte: Moreira (2014) 

 

Pela Figura 3, é possível ser a semelhança com as fases gerais descritas por Hillier e 

Lieberman. Contudo, Moreira propõe um passo a passo diferente a depender dos dados e da 
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sua coleta. Então, caso os dados não sejam estruturados, Moreira (2004) propõe a procura de 

uma solução por meio de análises qualitativas e julgamento da situação; ocorrendo dados 

estruturados e não estruturados, a modelagem matemática será usada apenas em partes 

específicas do problema, em que os dados sejam quantificáveis.  

Para Ackoff e Sasieni (1977), a manipulação das variáveis depende da natureza do 

modelo. A solução pode ser extraída do modelo mediante experimentação (i.e. por simulação) 

ou mediante análise matemática. Em alguns casos, a análise matemática pode ser conduzida 

sem que se tenha qualquer ideia a respeito dos valores das variáveis (i.e. abstrata ou 

simbolicamente), mas em outros casos é necessário conhecer tais valores (i.e. concreta ou 

numericamente). 

Ademais, Frederick H. Murphy (2005) descreve uma lista típica, muito similar a 

descrita anteriormente, de procedimentos usados em pesquisas de PO em seu artigo ASP, The 

Art and Science of Practice: Elements of a Theory of the Practice of Operations Research: A 

Framework. A lista é a seguinte: (i) reconhecer os sintomas; (ii) observar a situação; (iii) 

defina o problema; (iv) selecionar as ferramentas apropriadas; (v) coletar dados; (vi) formular 

um modelo matemático (se necessário); (vii) validar o modelo; (viii) definir cenários e 

resolver o modelo; (ix) analisar os resultados; (x) comunicar a análise; (xi) implementar uma 

solução para o problema com base em análise. 

 

3.2.4 Modelo de Pesquisa Operacional 

 

“Um modelo é uma representação de um objeto, sistema ou ideia em alguma forma 

outra que não a própria entidade” (SHANNON, 1975, p.123). De acordo com Ackoff e 

Sasieni (1977), os modelos podem ser caracterizados como físicos ou matemáticos. Os 

modelos físicos, ou icônicos, se parecem com o que eles representam, diferenciando em 

tamanho; i.e. são réplicas de dimensões reduzidas, em grande maioria. Para os autores, os 

modelos icônicos são específicos, concretos e de difícil manipulação em estudos 

experimentais, principalmente para os pesquisadores operacionais e analistas de sistemas. Os 

modelos matemáticos, também chamados de abstratos ou simbólicos, utilizam símbolos 

matemáticos para representação de relacionamentos lógicos e quantitativos. 

Para tanto, os modelos de estudo em PO assumem a forma matemática, i.e. assumem a 

forma de equações com diversos níveis de complexidade; ademais, em sua grande maioria, há 
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necessidade de uma ou mais equações ou inequações para traduzir a condição de que algumas, 

ou todas, variáveis controladas só podem ser manipuladas dentro de limites. Diversos autores, 

como Cassadras e Lafortune (1999), Banks et al. (1996), Soares (1990), Ehrlich (1985) e 

Forrester (1961), sugerem outras classificações de modelos. É possível visualizar uma síntese 

dessas classificações, descrita por Gavira (2003), abaixo. 

a) Linear ou não linear: 

− Modelos lineares são aqueles que seguem uma lei linear; i.e. sempre haverá a 

mesma resposta da variável endógena a uma variável independente ou exógena 

− Modelos não lineares são aqueles que não seguem uma lei linear; i.e. o 

relacionamento das variáveis endógenas e exógenas não se dá através de relações 

lineares 

b) Estático ou dinâmico: 

− Modelos estáticos são aqueles que representam um sistema em um ponto 

particular no tempo; os modelos de Monte Carlo são exemplos de modelos 

estáticos 

− Modelos dinâmicos são aqueles que representam sistemas à medida que eles 

evoluem ao longo do tempo 

c) Estável ou instável: 

− Modelos estáveis são aqueles, quando dinâmico, sempre se volta à condição 

inicial após um distúrbio 

− Modelos instáveis são aqueles que representam sistemas dinâmicos que após sua 

ativação, tendem a desenvolver a sua amplitude de movimentação, afastando-se 

da sua condição inicial 

d) Discreto ou contínuo: 

− Modelos discretos são aqueles em que as variáveis se modificam discretamente 

em pontos específicos do tempo simulado 

− Modelos contínuos são aqueles em que as variáveis podem variar continuamente 

ao longo do tempo simulado 

e) Determinístico ou estocástico: 

− Modelos discretos são aqueles em que as variáveis se modificam discretamente 

em pontos específicos do tempo simulado 
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− Modelos contínuos são aqueles em que as variáveis podem variar continuamente 

ao longo do tempo simulado 

f) Analítico ou de simulação: 

− Modelos analíticos são aqueles em que a estrutura é representada por uma série 

de equações matemáticas 

− Modelos de simulação são aqueles em que a estrutura é representada por 

equações matemática ou lógica para mimetizar o comportamento de um sistema 

ou mais 

 

É possível dividir os modelos de um estudo de pesquisa operacional da mesma 

maneira que os modelos de simulação (LAW; KELTON, 1991; SHUT, 2007; GAVIRA, 2003 

APUD WELLINGTON, 2007). Na Figura 4, é desenhado um esquema das classificações de 

um modelo.  

 

Figura 4: Classificação do Modelo de Simulação 

Fonte: Castro (2006) 

 

3.2.5 Técnicas de Pesquisa Operacional 

 

Uma consequência importante da aplicação da PO a uma grande variedade de 

problemas, e também da construção de algoritmos matemáticos, i.e. construção das equações, 

é a verificação e representação de diversos problemas em um pequeno número de problemas 

típicos. Alocação, estoque, substituição ou reposição, filas de espera, sequência e 
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coordenação, determinação de rotas, situações de competição, busca de informações são 

alguns exemplos desses tais problemas típicos (ACKOFF; SASIENI, 1977). 

De acordo com Andrade (2002) em seu livro Introdução à Pesquisa Operacional: 

Métodos e Modelos, as diferentes técnicas da PO são aplicadas a uma ampla variedade de 

problemas decisórios como determinação de tempo em filas de um banco até filas de aviões 

em aeroportos, problemas de estoques, planejamento da produção, mistura de componentes, 

formulação de ração a custo mínimo, redes de transporte, alocação de pessoas, problemas de 

redes de comunicação, alocação de investimentos, programação de tarefas e tantos outros. 

Para tanto, a pesquisa operacional abrange um conjunto relativamente grande de técnicas que 

podem ser utilizadas em um estudo de pesquisa operacional.  

A utilização das técnicas de Pesquisa Operacional justifica-se pela necessidade de 

evidenciar e tornar mais amplo os estudos feitos nesta área, já que a globalização trouxe 

consigo um ambiente competitivo, onde se torna necessários a utilização de recursos que 

garantam a eficiência e viabilidade de investimento, e aplicações de métodos matemáticos que 

minimizem as incertezas nas decisões tomadas pelos administradores (SANTOS; SOUZA; 

MORAIS, 2008). 

As principais técnicas da PO são: algoritmos genéticos, análises multicritério de apoio 

à decisão, cadeias de Markov, Data Envelopment Analysis – DEA, grafos, modelos de 

estoques, modelos de previsão, programação dinâmica, programação matemática, redes 

neurais, simulação de sistemas, teoria da decisão, teoria das filas, teoria dos jogos 

(ANDRADE, 2002). É possível encontrar na literatura outras categorias de técnicas ou até 

mesmo a interpretação de modelos como técnicas; contudo, sempre há semelhanças entre 

todas elas. Um exemplo são as técnicas apresentadas por Ackoff e Sasinieni (1968), no livro 

Fundamentals of Operations Research, em que para eles a programação inteira pode ser 

desagregada em três outras técnicas como a programação linear, não linear e inteira. 

Segundo Ackoff e Sasinieni (1968), portanto, as técnicas de pesquisa operacional 

podem ser divididas entre: programação linear, programação não-linear, programação inteira, 

teoria das filas, simulação, teoria dos jogos, entre outras. Outro exemplo são as categorias 

propostas por Ecker e Kupferschmid (1988), em que a necessidade de se fazer escolhas ótimas 

em situações de incerteza determina duas categorias principais de métodos matemáticos 

usados na pesquisa operacional: (i) otimização, e (ii) probabilidade aplicada. A otimização 

engloba as programações matemáticas, como a programação linear, não-linear, inteira e 
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dinâmica, e a probabilidade aplicada engloba os modelos de estoque, simulação e teoria das 

filas, por exemplo. 

Contudo, as técnicas de pesquisa operacional mais difundidas, segundo Rodrigues et 

al. (2014), são apenas quatro: (i) programação matemática (linear, não-linear e inteira); (ii) 

simulação computacional; (iii) teoria dos jogos; (iv) teoria das filas; e, (v) PERT/CPM.  

"Programação linear é uma técnica que pressupõe a relação linear entre as 

características do problema, buscando a solução ótima para o problema estudado (...) 

Simulação computacional é uma técnica que simula as características estudadas em 

um modelo de computador, considerando a variabilidade dos comportamentos do 

ambiente e seus participantes (...) Teoria dos jogos é uma técnica matemática que 

busca antecipar as possíveis decisões de participantes de uma situação de 

competição (...) Teoria das filas é o estudo das esperas existentes nos mais diversos 

sistemas, tais como filas de banco, do caixa no supermercado e outras não tão 

corriqueiras a todo mundo como as ordens de produção aguardando para serem 

liberadas ou os veículos que aguardam para serem descarregados e assim atrasam 

outros carregamentos posteriores (...) PERT/CPM - PERT é a sigla de Program 

Evaluation and Review Technique (Técnica de Avaliação e Revisão de Projetos) e 

CPM é a sigla de Critical Path Method (Método do Caminho Crítico) - ambas as 

técnicas envolvem modelos de redes visando a gestão de tempo de projetos (...)" 

(Rodrigues et al, 2014). 

 

Rodrigues (1995) apud Wellington (2017) descrevem uma adequação de quatro 

diferentes técnicas da área da pesquisa operacional em relação a variabilidade e complexidade 

do modelo, i.e. mostra a classe de técnicas que é mais indicada, conforme a complexidade e a 

variabilidade dos problemas estudados. Na Figura 5 abaixo, é possível ver a indicação da 

técnica a ser utilizada no estudo de acordo com grau de variabilidade dos dados e com grau de 

complexidade do problema; por exemplo, a técnica de simulação é indicada em casos de alta 

variabilidade dos dados e da alta complexidade do problema. 

 

Figura 5: Adequação de Diferentes Técnicas de Modelagem em relação à Variabilidade e Complexidade do 

Modelo 

Fonte: Wellington (2007) 
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3.2.6 Programação Linear 

 

O desenvolvimento da programação linear tem sido classificado entre os mais 

importantes avanços científicos dos meados do século XX (HILLIER; LIEBERMAN, 2013). 

"Seu impacto desde 1950 tem sido extraordinário", afirmaram Hillier e Lieberman (2013).  

Os primeiros casos a serem reportados na academia sobre aplicação das técnicas de 

pesquisa operacional foram, em virtude de sua origem, de caráter militar; porém, somente 

após o final da Segunda Grande Guerra, problemas civis passaram a ser estudados pela PO. 

Os primórdios da PO encontram-se descritos no trabalho de Trefethen (1954). Contudo, dois 

eventos foram responsáveis pelo rápido desenvolvimento de estudos da PO e, 

consequentemente, pelo o reconhecimento da sua importância para a comunidade científica 

no século anterior.  

Segundo Wayne L. Winston (1994), o primeiro evento foi o desenvolvimento de um 

algoritmo simples para solucionar problemas de programação linear, denominado algoritmo 

simplex e proposto por George Dantzig em 1947. Tal algoritmo permitiu a resolução manual 

de diversos estudos da PO, principalmente aqueles de baixa complexidade. O segundo evento 

foi a proliferação dos microcomputadores e o rápido aumento em sua velocidade de 

processamento. 

A programação linear é construída a partir de um modelo matemático (ou 

programação matemática) para descrição do problema em questão. "O adjetivo linear significa 

que todas as funções matemáticas nesse modelo são necessariamente funções lineares. A 

palavra programação, nesse caso, não se refere à programação de computador; ela é, 

essencialmente, um sinônimo para planejamento" (HILLIER; LIEBERMAN, 2013, p.20). 

Assim, a programação linear pode ser descrita como o planejamento de atividades, por 

exemplo, para a obtenção de um resultado ótimo. É um resultado que atinge o melhor objetivo 

especificado, de acordo com o modelo matemático construído, entre todas as alternativas 

viáveis. 

"O tipo mais comum de aplicação de programação linear envolve alocar recursos 

limitados a atividades" (HILLIER; LIEBERMAN, 2013, p.20), para tanto, em um problema 

de programação linear, os termos-chave são recursos e atividades, onde m representa o 

número dos diferentes tipos de recursos a serem utilizados em n atividades consideradas 

(HILLIER; LIEBERMAN, 2013). Alguns exemplos de recursos e atividades são: 
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a) Recursos: dinheiro, máquinas, equipamentos, veículos, pessoal e outros; 

b) Atividades: investimentos em projetos, anúncio em média direcionada, processos de 

produção, transporte de mercadorias. 

 

A fim de determinar a alocação de recursos em atividades, o modelo de programação 

linear envolve escolher os níveis das atividades que conduzem ao melhor valor possível da 

medida de desempenho global.  

A terminologia comum de um modelo de programação linear, segundo Hillier e 

Lieberman (2013), para um problema genérico são: m recursos; n atividades; nível de 

atividade j, xj; e, medida de desempenho global Z. Para tanto, certos símbolos são comumente 

usados para representar os diversos componentes de um modelo de programação linear. 

 z = valor da medida de desempenho global 

 xj = nível de atividade j, para j = 1, 2, 3, … , n 

 cj = incremento em Z que resultaria de cada incremento unitário no nível de 

atividade j 

 bi = quantidade do recurso i que se encontra disponível para alocação em 

atividades, para i  = 1, 2, 3, …, m 

 aij = quantidade do recurso i consumido por unidade de atividade j 

Portanto, o modelo formula o problema em questão para decidir os níveis de 

atividades, i.e. para determinar as variáveis de decisão - x1, x2, x3, ... xj. Os valores de bi e aij 

são, então, as constantes de entrada para o modelo; i.e. são os parâmetros definidos para o 

problema.  

 

3.2.6.1 Uma forma-padrão do modelo 

 

Uma forma padrão de desenhar um modelo para o problema de programação linear é 

por meio de sua função de desempenho global e de suas limitações. A função a ser 

maximizada chama-se função objetivo; as limitações de recursos e/ou atividades são 

denominadas de restrições, as quais podem ser classificadas como restrições funcionais ou 

restrições de não negatividade. As restrições funcionais, ou estruturais, são aquelas primeiras 

m restrições, em que todas as variáveis aijxj + aijxj + ... + amnxn são posicionadas no lado 
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esquerdo; já as restrições de não negatividade, ou de condições não negativas, são aquelas 

posicionadas por último, garantindo a positividade numérica dos resultados. Portanto, a 

forma-padrão do modelo de programação linear é: 

 

Maximizar z = c1x1 + c2x2 + ... + cnxn, 

sujeito às restrições 

a11x1 + a12x2 + ... + a1nxn ≤ b1 

a21x1 + a22x2+ ... + a2nxn ≤ b2 

… 

am2x2 + am2x2 + ... + amnxn ≤ bm 

e 

x1 ≥ 0, x2 ≥ 0, ... xn ≥ 0 

 

Esse formato também recebe o nome de formulação primal de programação linear. As 

características mais importantes do modelo primal são, portanto: (i) a função objetivo é do 

tipo maximizar; (ii) todas as restrições são expressas como equações; (iii) todas as variáveis 

são não negativas; e, (iv) a constante no lado direito das restrições é não negativa 

(MANSILHA; FARRET; KULLMANN, 2017). Ademais, existem outras formas legítimas de 

representar, como: minimizar em vez de maximizar a função objetivo, restrições funcionais 

com desigualdade maior do que ou igual, restrições funcionais de igualdade, e restrições não 

negativas eliminadas (i.e xn irrestrita em sinal) (HILLIER; LIEBERMAN, 2013). 

 

3.2.6.2 Terminologia para soluções de Modelo 

 

A terminologia utilizada para as soluções de modelos objetiva diferenciar e classificar 

os tipos de solução entre as viáveis, inviáveis e ótimas. Uma solução viável é aquela para a 

qual todas as restrições são satisfeitas; uma solução inviável é aquela para a qual pelo menos 

uma das restrições é violada; uma solução ótima é uma solução viável que possui o valor mais 

favorável da função objetivo. Segundo Hillier e Lieberman (2013), a maioria dos problemas 

apresenta apenas uma solução ótima, porém é possível que não haja uma solução viável, e 
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consequentemente nenhuma solução ótima, ou até mesmo que Z seja ilimitado, i.e. as 

restrições não impedem o aumento do valor da função objetivo, também não apresentando 

uma solução ótima para o problema.  

Uma outra definição importante para um problema de programação linear é a solução 

ponto extremo factível - PEF. As PEF são aquelas posicionadas em um vértice da região de 

soluções; ou seja, posicionadas em pontos extremos. A relação entre as soluções ótimas e as 

soluções PEF é que, para problemas com uma região de soluções viáveis existente e limitada, 

sempre existirão soluções PEF e pelo menos uma solução ótima (HILLIER; LIEBERMAN, 

2013). 

 

3.2.6.3 Hipóteses  

 

Encontradas implicitamente na formulação matemática, as hipóteses da programação 

linear são: (i) de proporcionalidade; (ii) de aditividade; (iii) de divisibilidade; e, (iv) de 

certeza.  

"Hipótese da proporcionalidade: a contribuição de cada atividade ao valor 

da função objetivo Z é proporcional ao nível de atividade xj , conforme representado 

pelo termo cjxj na função objetivo; e a contribuição de cada atividade do lado 

esquerdo de cada restrição funcional é proporcional ao nível de atividade xj, 

conforme representado pelo termo aijxj na restrição (...) Hipótese da aditividade: toda 

função em um modelo de programação linear, seja a objetivo ou a de restrição, é a 

soma das contribuições individuais das respectivas atividades (...) Hipótese da 

divisibilidade: as variáveis de decisão em um modelo de programação linear podem 

assumir quaisquer valores, inclusive valores não inteiros, que satisfaçam as 

restrições funcionais e de não negatividade (...) Hipótese da certeza: assume-se o 

valor atribuído a cada parâmetro de um modelo de programação linear como uma 

constante conhecida" (HILLIER; LIEBERMAN, 2013, p.32-38). 

 

Contudo, é muito comum nas aplicações de programação linear que quase nenhuma 

das quatro hipóteses, descritas acima, se sustente completamente. Deste modo, é necessário 

apenas que haja uma correlação relativamente grande entre as previsões do modelo e o 

problema no mundo real. É de extrema importância, portanto, a equipe de PO realizar 

experimentos de pós-otimalidade, como a análise de sensibilidade, para examinar se as 

hipóteses se sustentam minimamente para o problema em questão e, também, para analisar a 

dimensão dessas disparidades (HILLIER; LIEBERMAN, 2013).  
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3.2.6.4 Formulação de modelos de PL de grandes dimensões 

 

A programação linear é um dos principais modelos da área de pesquisa operacional. 

Fundamental para a resolução de problemas, os algoritmos e suas extensões para resolver um 

problema desse tipo formam uma grande parte da computação. Independente do uso da 

tecnologia computacional, a conceituação de perspectivas futuras requer a construção de um 

modelo, mais especificamente de uma série de modelos. A capacidade do cérebro humano é 

limitada, principalmente pela sua capacidade de montar e lembrar dos resultados de uma 

iteração de mais do que sete variáveis, em seu máximo. A operação do cérebro humano em 

tais níveis de desempenho de 'processamento' são problemáticos; para tanto, a abordagem 

mais próxima da simulação de um cérebro é por meio de computadores (BVAUERS, 2002). 

 

3.2.6.5 Método Simplex  

 

Reconhecido como o pai da programação linear, George Dantzig foi o mais importante 

pioneiro da pesquisa operacional, desenvolvendo o método simplex. Esse procedimento 

provou ser extremamente eficiente para solucionar problemas de programação linear, sendo 

considerado o método mais utilizado para resolução de problemas, tanto de pequeno quanto 

de grande porte (HILLIER; LIEBERMAN, 2013; PLOSKAS, 2015; SAMARAS, 2015). 

Diversos autores utilizam do método para resolver problemas de engenharia (YAMAMURA; 

KITAWA, 2003; VELILLA; VALENCIA; MORENO, 2008). 

O método simplex se caracteriza como um procedimento algébrico além de apresentar 

conceitos subjacentes geométricos. A solução ótima do problema é determinada 

numericamente pela característica interativa do método. Para Ploskas e Samaras (2014), a 

escolha do elemento de articulação em cada iteração é um dos passos mais críticos para o 

algoritmo simplex.  

Segundo Hillier e Lieberman (2013), há seis conceitos-chave para soluções de 

problema de programação linear utilizando-se do método simplex. São eles: 

a) Conceito para solução 1: o método simplex concentra-se exclusivamente em 

soluções PEF; para qualquer problema com pelo menos uma solução ótima, para 

encontrá-la basta encontrar a melhor solução PEF; 

b) Conceito para solução 2:  o método simplex é um algoritmo iterativo, i.e. um 

procedimento sistemático para solução que repete uma série de etapas, chamadas 
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iteração, até que se chegue a um resultado desejado; 

c) Conceito para solução 3: sempre que possível, a inicialização do método opta pela 

origem como a solução PEF inicial; 

d) Conceito para solução 4: dada uma solução PEF, a próxima iteração será adjacente a 

solução atual; ou seja, o método sempre opta por uma solução PEF adjacente a 

solução atual; 

e) Conceito para solução 5: o método examina cada um dos lados da região de soluções 

viáveis provenientes dessa solução PEF; ou seja, o método identifica a melhor 

solução através da taxa de crescimento de Z, deslocando-se ao longo do lado com 

maior taxa de crescimento; e, 

f) Conceito para solução 6: o método realiza de modo eficiente, por fim, o teste de 

otimalidade; o teste consiste em verificar se qualquer um dos lados resulta em uma 

taxa de crescimento em Z positiva e se nenhum atender a isso, então, a solução PEF 

atual é a solução ótima. 

 

Portanto, o método simplex segue a estrutura representada pela Figura 6 abaixo. 

 

Figura 6: Estrutura do Método Simplex 

Fonte: Hillier e Lieberman (2013, p.87) 

 

Contudo, a configuração do método simplex quando executado em um computador 

deve seguir somente instruções algébrica. A primeira etapa nessa configuração é converter as 

restrições funcionais de desigualdade em restrições de igualdade equivalentes a partir da 

introdução de variáveis de folga, ou variável de excesso. O modelo assume agora sua forma 
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aumentada, um modelo equivalente da forma original do modelo. Essa conversão é 

fundamental para a manipulação algébrica do modelo pelo computador, e também para a 

identificação das soluções PEF (HILLIER; LIEBERMAN, 2013). Na Figura 7  abaixo, são 

apresentados os dois formatos do modelo e as duas interpretações de como o método simplex 

soluciona um problema de programação linear.  

 

 

Figura 7: Formatos do Modelo de PL para Solução via Método Simplex 

Fonte: Hillier e Lieberman (2013) 

 

A terminologia correspondente para a forma aumentada é: (i) uma solução aumentada 

é uma solução para as variáveis originais, i.e. de decisão, que foi aumentada pelos valores 

correspondentes das variáveis de folga; (ii) uma solução básica é uma solução em ponto 

extremo aumentada; e, (iii) uma solução básica viável (BV) é uma solução PEF aumentada 

(HILLIER; LIEBERMAN, 2013).  

Por último, os códigos computacionais adaptam a forma algébrica e aumentada do 

método simplex em uma forma matricial, i.e. método simplex revisado.  

"Essa forma realiza exatamente as mesmas etapas da forma geométrica, 

algébrica e tabular, porém ela faz isso enquanto processa e armazena apenas os 

números que são efetivamente necessários para a iteração atual e depois transporta 

os dados essenciais de uma forma muito mais compactada" (HILLIER; 

LIEBERMAN, 2013, p.128). 

 

Para solucionar um problema de programação linear, há diversos fatores que afetam o 

seu tempo de processamento. Para Hillier e Lieberman (2013), o mais importante deles é o 

número de restrições funcionais ordinárias frente a sua característica de proporcionalidade ao 

cubo; ou seja, a grosso modo, o ato de dobrar o número de restrições pode multiplicar o tempo 

de processamento por um fator aproximadamente igual a oito. Ademais, existe ainda um fator 
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de relativa importância: a densidade da tabela de coeficientes de restrições (i.e. a proporção 

dos coeficientes não-zeros do modelo). Uma regra prática para o número de iterações é que 

ele tende a ser aproximadamente o dobro do número de restrições funcionais.  

Portanto, segundo Chvatal (1983), o algoritmo simplex pode ser resumido nos 

seguintes passos: 

Passo 0: Formar a matriz correspondente a uma solução básica viável 

Passo 1: Se todos rj ≥ 0, pare; a solução básica viável atual já é ótima 

Passo 2: Selecionar  q tal que  rq < 0 para determinar qual variável não básica irá se 

tornar básica 

Passo 3: Calcular as razões yi0/yiq para yiq ≥ 0 , i = 1, 2, ..., m; se nenhum yiq ≥ 0, pare, 

o problema é ilimitado. Caso contrário, selecionar p como sendo o índice i correspondente à 

menor razão 

Passo 4: Pivotear no pq-ésimo elemento, atualizando todas as linhas incluindo a 

última; retornar ao passo 1. 

 

3.2.7 Problemas de transporte 

 

Um tipo particular de problema da programação linear é o de transporte. O problema 

de transporte, apesar do seu nome, não se refere exclusivamente a aplicações do modelo no 

transporte de mercadores de maneira otimizada, mas também a outros desafios como, por 

exemplo, o de cronograma de produção (HILLIER; LIEBERMAN, 2013). Para tanto, 

segundo os autores, "o problema de transporte genérico se refere a distribuir qualquer 

commodity de qualquer grupo de centros de fornecimento, chamado de origens, a qualquer 

grupo de centros de recepção, denominados destinos, de modo a minimizar o custo total de 

distribuição" (HILLIER; LIEBERMAN, p.294). 

Reconhecido como um dos problemas de otimização mais estudado, o problema de 

transporte foi introduzido por Dantzig e Ramser em 1959 para aplicação do algoritmo 

matemático em um problema de oferta e demanda de gasolina. Em 1964, Clarke e Wright 

propõem uma abordagem heurística para os problemas de transporte, melhorando a 

abordagem de Dantzig e Ramser. Posteriormente, centenas de modelos foram propostos para 
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encontrar soluções aproximadas (DANTZIG et al., 1959; CLARKE et al., 1964; TOTH et al., 

2002).  

De acordo com Toth et al. (2002), o problema consiste na distribuição de mercadorias 

em um período de tempo de um conjunto de clientes por um conjunto de veículos. Esses 

veículos estão localizados em depósitos, são operados por motoristas e realizam seus 

movimentos por meio de uma malha rodoviária. Para tanto, a solução passa por um conjunto 

de rotas, realizadas por veículos que iniciam e terminam em seus depósitos de forma que (i) 

os requisitos do cliente sejam atendidos, (ii) as restrições operacionais sejam atendidas e (iii) 

os custos de transporte sejam minimizados. Portanto, os objetivos típicos de um problema 

desse tipo são a minimização do custo global de transporte, a minimização do número de 

veículos usados, o balanceamento das rotas e a minimização das penalidades associadas ao 

serviço incompleto. 

A terminologia comum para um problema genérico de transporte, segundo Hillier e 

Lieberman (2013), são: unidades de uma commodity; m origens; n destinos; oferta si da 

origem i;  demanda dj da origem j; e, custo cij por unidade distribuída da origem i para o 

destino j. Portanto, fazendo que z da função objetivo seja o custo total de distribuições e xij( i 

= 1, 2, ..., m; j = 1, 2, ..., n) seja o número de unidades a serem distribuídas da origem i para o 

destino j, a formulação padrão em programação linear de um problema desse tipo fique: 

 

Para tanto, qualquer problema de programação linear que se encaixe nessa formulação 

especial é do tipo problema de transporte, independentemente de seu contexto físico. 

Contudo, em alguns problemas reais, as ofertas representam quantidades máximas, e não 

fixas, a serem distribuídas; de modo similar, as demandas no mundo real podem também 
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representar quantidades máximas a serem recebidas. Portanto, há dois grupos principais de 

problemas de transporte: o problema de transporte balanceado e, o não-balanceado. 

Para Anuradha (2016), há diferentes tipos de problemas de transporte nos quais podem 

ser classificados como: (i) problema de fluxo de custo mínimo; (ii) problema de fluxo de 

custo mínimo com diferentes restrições; (iii) problema do caminho mais curto (ou de gargalo 

em tradução livre); e, por fim, (iv) problema de multi-objetivo. 

 

"O problema de fluxo de custo mínimo (...) que o objetivo do problema de 

transporte é determinar a programação de remessa que minimiza o custo total de 

remessa enquanto satisfaz os limites de oferta e demanda (...) O problema de fluxo 

de custo mínimo com diferentes restrições (...) é utilizado com menor frequência na 

academia frente ao rigor técnico para solucionar um problema desse tipo (...) O 

problema do caminho mais curto é um tipo especial (...) em que um período de 

tempo está associado a cada rota de envio. O objetivo deste processo é minimizar o 

tempo máximo para transportar todo o abastecimento para os destinos, em vez de 

minimizar o custo (...) Em geral, os problemas da vida real são modelados com 

multi-objetivos que são medidos em diferentes escalas (...) Uma variedade de 

abordagens, como a abordagem de programação de objetivo lexicográfica, 

abordagem de programação de objetivo de intervalo, algoritmos iterativos, 

abordagem difusa de programação, o método de etapas, o método de função de 

utilidade foram desenvolvidos por muitos pesquisadores para o problema de 

programação linear multi-objetivo" (Anuradha, 2016, p.2-7). 

 

Uma outra visualização dos problemas de transporte, mais especificamente de rotas, é 

proposta por Hassanzadeh et al (2009) e Toth et al (2002). Na Figura 8 abaixo, é possível 

visualizar os problemas de transporte principais e suas interconexões.  

 

 

Figura 8: Problemas básicos de transportes e suas interconexões 

Fonte: Toth et al., 2002  
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O CVRP significa um problema de transporte capacitado, em que todos os clientes 

correspondem às ofertas, as demandas são determinísticas e não podem ser parceladas. 

VRPTW significa VRP com janelas de tempo; ou seja, para cada cliente, o atendimento inicia 

dentro de uma janela de tempo e os veículos param por instantes de tempo. VRPB significa 

VRP com gargalos; ou seja, o conjunto de clientes é dividido em dois subconjuntos, clientes 

Linehaul (sem gargalo) e clientes Backhaul (com gargalo), de forma que sempre que uma rota 

atende os dois tipos de clientes, todos os clientes sem gargalo devem ser atendidos antes dos 

clientes com gargalo. VRPPD significa VRP com coleta e entrega; ou seja, cada cliente está 

associado a duas quantidades de demanda de mercadorias homogêneas, a serem entregues e a 

serem retiradas em um cliente (TOTH et al., 2002). Além disso, os outros dois problemas 

básicos são variações dos apresentados, em que VRPBTW significa VRP com gargalo e 

janelas de tempo e VRPPDTW para VRP com coleta e entrega e janelas de tempo 

(HASSANZADEH, 2009). 

Portanto, o problema de transporte é frequentemente utilizado para o desenvolvimento 

de novos modelos e técnicas algorítmicas aplicadas para a solução eficaz de problemas de 

otimização combinatória (TOTH et al., 2002). O uso bem-sucedido dessas técnicas se deve a 

tecnologia, mais especificamente: (i) ao poder dos sistemas computacionais atuais; (ii) 

integração de sistemas de informação em processos; (iii) desenvolvimento de modelos 

matemáticos rigorosos; (iv) aplicabilidade no mundo real; e, (v) relevância prática (TOTH et 

al., 2014). 

 

2.5 Geoprocessamento 

 

Para Câmara et al (2001), o Brasil é um país de dimensão continental com uma grande 

carência de informações adequadas para a tomada de decisões sobre os problemas urbanos, 

rurais e ambientais, em que o Geoprocessamento apresenta um enorme potencial, 

principalmente por se basear em tecnologias de custo relativamente baixo. Os produtos 

gerados por um Sistema de Informação Geográfica – SIG “vinculam-se ao espaço físico, 

podendo, entretanto, trabalhar fenômenos climáticos, humanos, sociais e econômicos. A partir 

desses espaços devidamente “mapeados” e trabalhados pelo SIG, pode-se conhecer melhor 

uma região, possibilitando, assim, o fornecimento de subsídios para uma futura tomada de 

decisões” (FITZ, 2008, p. 25).  



45 

 

Para tanto, nesta seção serão descritos a definição, importância, história e os sistemas 

dessa área de conhecimento em potencial para tomadas de decisões mais assertivas, i.e. do 

Geoprocessamento. 

 

3.3.1 Definição de Geoprocessamento 

 

O geoprocessamento consiste em um conjunto de técnicas, métodos e ferramentas 

matemáticas e/ou computacionais para o tratamento da informação geográfica; essa área do 

conhecimento influencia e proporciona a análise de recursos naturais, de transporte, das 

comunicações, de energia, do planejamento urbano e regional, e de outros aspectos 

(IBRAHIN et al, 2016; CÂMARA; DAVIS, 2001, p.1). Para tanto, o geoprocessamento é 

visto como uma área de conhecimento a qual envolve diferentes disciplinas como, por 

exemplo, a cartografia, computação, geografia e estatística (IBRAHIN, 2016). “Tudo o que 

está ao nosso redor pode ser georreferenciado, ou seja, pode ter as suas coordenadas 

conhecidas, como árvores, rios, prédios, postos de saúde, pontos de ônibus, residências, 

fábricas, ruas e etc” afirmou Francini Ibrahin (2016) em seu livro Introdução ao 

Geoprocessamento Ambiental.  

Geoprocessamento, de acordo com Rodrigues (1988), denota um sistema de coleta e 

tratamento de informações espaciais e cartográficas interpoladas com dados estatísticos, junto 

a um software que processa esses dados de forma gerencial. Para Macedo (2018), o 

geoprocessamento é um ramo do conhecimento, ou seja, é a “ciência da geoinformação”. 

As ferramentas computacionais para o geoprocessamento, chamadas de Sistemas de 

Informação Geográfica - GIS, ou SIG em inglês, permitem realizar análises complexas ao 

integrar dados de diversas fontes e ao criar bancos de dados georreferenciados. Para tanto, 

essa ferramenta computacional facilitou a aplicabilidade e produtividade do 

geoprocessamento em ambiente digital, com cálculos e análises estatísticas realizadas de 

maneira escalonada. Portanto, o GIS torna possível automatizar o processo de produção de 

documentos cartográficos, sendo um local de automação, por exemplo, da produção de mapas 

(CÂMARA et al., 2000; CÂMARA et al., 2004; FUKS et al., 2004; MAGUIRE et al., 2005; 

SILVA et al., 2008; MACEDO, 2018). 

A dinâmica interdisciplinar e tecnológica entre cartografia, geoprocessamento e 

espaço geográfico permite um grande avanço na coleta, tratamento e análise das informações 

com distribuição geográfica. Da cartografia, constrói-se, por meio de modelos matemáticos, 
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um modelo de representação de dados para os processos ocorridos no espaço geográfico. Do 

geoprocessamento, utiliza-se da sua interação entre técnicas matemáticas-estatísticas e 

computacionais fornecidas pelos Sistemas de Informação Geográfica - SIG para tratar esses 

processos do espaço geográfico; i.e informações geográficas. Portanto, essa descrição 

relaciona de forma clara a interdisciplinaridade entre a cartografia, o geoprocessamento e os 

Sistemas de Informações Geográficas (BURROUGH; MCDONNELL, 2004; CÂMARA et 

al., 2004; MAGUIRE et al., 2005).  

 

3.3.2 Importância do Geoprocessamento 

 

Segundo Câmara et al. (2001), o problema fundamental da ciência da geoinformação é 

o estudo e a implementação de diferentes formas de representação computacional do espaço 

geográfico. Para tanto, costuma-se dizer que o geoprocessamento é uma tecnologia 

interdisciplinar, a qual permite a convergência de diferentes disciplinas científicas para 

estudos de fenômenos ambientais e urbanos; ou seja, "o espaço é uma linguagem comum" 

para diferentes disciplinas científicas.  

Ademais, muitas decisões políticas são adotadas ao considerar o fator localização 

como, por exemplo: a verificação da densidade demográficas, da renda média e da área de 

abrangência de outros postos já existentes para a construção de um novo posto de saúde, ou 

até mesmo a realização de serviços eficientes nas redes de energia elétrica e de 

telecomunicações (IBRAHIN et al, 2016).  

Para as atividades das sociedades organizadas, a coleta de informações sobre a 

distribuição geográfica de recursos minerais, propriedades, animais e plantas sempre foi de 

extrema importância. Contudo, a coleta e a manipulação de dados geográficos eram 

realizadas, até a segunda metade do século XXI, através de ferramentas limitadas como 

documentos e mapas em papel. Para tanto, com o desenvolvimento simultâneo da tecnologia 

de informação e do pensamento geográfico, tornou-se possível armazenar e representar tais 

informações em ambiente computacional, abrindo espaço para o aparecimento e 

desenvolvimento do geoprocessamento (CAMARA et al, 2001). 

A utilização das imagens de satélites e fotografias aéreas, mapas, banco de dados e 

aplicativos específicos no geoprocessamento permite a melhor manipulação de informações, 

podendo-se identificar determinadas características da superfície terrestre e ordená-las em 



47 

 

cores, formas e legendas variadas. Em outras palavras, a análise espacial possibilita: (i) 

manipular dados georreferenciados de diferentes formas; (ii) extrair conhecimento adicional 

como resposta, incluindo a manipulação de mapas, imagens de satélites e aerofotos; (iii) 

produzir alguns breves resumos estatísticos de informações geográficas; e, (iv) incorporar 

funções como a investigação de padrões e relacionamentos dos dados. Portanto, o 

geoprocessamento e as análises espaciais buscam um melhor entendimento de um fenômeno 

em específico, e trazem a possibilidade de se fazer predições desse mesmo fenômeno 

(BAILEY, 1994, apud ROCHA, 2004).   

 

3.3.3 História do Pensamento Geográfico e do Geoprocessamento 

 

Para Câmara e Davis (2001, p.5-13), a história do pensamento geográfico e do 

geoprocessamento podem ser divididas em quatro grandes fases: (i) geografia idiográfica; (ii) 

geografia quantitativa I; (iii) geografia quantitativa II; e, (iv) geografia crítica.  

a) Geografia Idiográfica (GIS dos anos 80): o conceito-chave é a unicidade da região, 

expresso através de abstrações como a “unidade-área”, “unidade de paisagem” e 

“land-unit”; a representação computacional associada é o polígono com seus 

atributos, os quais são usualmente expressos numa tabela de um banco de dados 

relacional e as técnicas de análise comuns está no uso da interseção de conjuntos i.e. 

na lógica booleana; 

b) Geografia  Quantitativa (GIS  de  hoje): o conceito-chave é a distribuição espacial  do 

fenômeno de estudo, expressa através de um conjunto de eventos, amostras pontuais, 

ou dados agregados por área; a representação computacional associada é a superfície 

expressa como uma grade regular e há uma grande ênfase no uso  de técnicas de 

estatística  espacial e lógica nebulosa (“fuzzy” em inglês)  para  caracterizar  com  o  

uso respectivamente da  teoria  da  probabilidade  e  da  teoria  da  possibilidade  as 

distribuições  espaciais, respectivamente; 

c) Geografia Quantitativa I (GIS da próxima geração):  o conceito-chave são os 

modelos preditivos com representação espaço-temporal, onde a evolução do 

fenômeno é expressa através de representação funcional; para capturar as diferentes 

relações dinâmicas são utilizadas técnicas de análise em modelos multi-escala para 

fenômenos tanto macros, como por exemplo fatores econômicos, quanto micros, 

como por exemplo estudos de transições no uso da terra; e, 
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d) Geografia  Crítica  (GIS do futuro): os conceitos-chave incluem o espaço como 

“sistema de objetos e sistemas de ações” e a oposição entre “espaço de fluxos” e 

“espaço de lugares”; aqui existe a especulação das representações computacionais, as 

quais possivelmente incluirão as técnicas de representação do conhecimento; ou seja, 

a hipótese é que os GIS do futuro contemplarão representações não-cartográficas do 

espaço, com ênfase no estabelecimento de relações  entre  os  diferentes  atores  

sociais  que  atuam  no  espaço. 

 

No Quadro 1 abaixo, é possível ver um resumo da descrição das diferentes fases da 

teoria geográfica e do geoprocessamento.  

 

Teoria 
Tecnologia GIS 

associada 
Conceito-chave 

Representação 

Computacional 

Técnicas de 

Análise 

Geografia 

Idiográfica 

Anos 80 – meados 

dos anos 90 

Unicidade da região 

(unidade-área) 

Polígonos e 

atributos 

Interseção e 

conjuntos 

Geografia 

Quantitativa – 1 

Final da década de 

90 
Distribuição espacial Superfícies (grades) 

Geoestatística e 

lógica fuzzy 

Geografia 

Quantitativa – 2 

Meados da década 

de 00 

Modelos espaço-

tempo 
Funções Modelos multi-escala 

Geografia Crítica 
Segunda década do 

século 21 

Objetos e ações; 

Espaços de fluxos e 

espaços de lugares 

Ontologias e 

espaços não-

cartográficos 

Representação do 

conhecimento 

 

Quadro 1: Teoria Geográfica e Geoprocessamento 

Fonte: Câmara e Davis (2001) 

 

Na década de 50, ocorreram os primeiros experimentos, em pesquisas inglesas e 

estadunidenses, para automatizar as informações geográficas a fim de reduzir os custos de 

produção e de manutenção de mapas. Entretanto, o surgimento do conceito de um sistema de 

informações geográficas ocorreu somente na década de 60 em terras canadenses, através de 

um programa do governo para criação de um inventário de recursos naturais. Ademais, na 

década de 70, foram desenvolvidos novos e mais acessíveis recursos de hardware, tornando 

possível o desenvolvimento de sistemas comerciais de informações e dando início a uma 
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tecnologia baseada em hardware e software utilizada para descrição e análise do espaço 

geográfico, i.e. a tecnologia do Sistema de Informação Geográfica - SIG. Desde a década de 

1980, é observado um crescimento constante na área de tecnologia de sistema de informações, 

marcado pela evolução e popularização dos computadores pessoais, bem como pelo menor 

custo de hardware e do software para armazenamento de informações geográficas. Portanto, a 

partir da década de 80, novos aplicativos, hardwares e softwares específicos do Sistema de 

Informação Geográfica - SIG foram surgindo para áreas como, por exemplo, agricultura, meio 

ambiente, obras de engenharia, segurança pública, energia, sanitarismo, transportes, serviços 

de emergência, telecomunicações, marketing, jornalismo e turismo (IBRAHIN, 2016). 

No Brasil, o geoprocessamento iniciou-se pela divulgação e formação de pessoal feitas 

pelo professor Jorge Xavier da Silva, da Universidade Federal do Rio de Janeiro - UFRJ, no 

início dos anos 1980. Outro fator que incentivou o aparecimento de vários grupos interessados 

em desenvolver o geoprocessamento em terras brasileiras foi a visita de Roger Tomlinson, 

responsável pela criação do primeiro SIG, o Canadian Geographical Information System no 

ano de 1982 (CÂMARA et al., 2001; IBRAHIN, 2016). Em 1991, a Divisão de 

Processamento de Imagens do Instituto Nacional de Pesquisas Espaciais - INPE cria o 

Sistema para Processamento de Informações Geográficas - Spring, unificando o tratamento de 

imagens de sensoriamento remoto, mapas temáticos e cadastrais, redes, modelos numéricos de 

terreno. 

 

3.3.4 Sistemas de Informação Geográfico - SIG 

 

“Se onde é importante para seu negócio, então o geoprocessamento é sua ferramenta 

de trabalho”, afirma Câmara et al (2001) em seu livro. Para os autores, sempre que a palavra 

"onde" aparece dentre questões acadêmicas, ou até empresariais, e existe necessidade da 

resolução do problema através de um sistema informatizado, haverá uma oportunidade para 

considerar a adoção de um SIG. Segundo a ESRI, uma empresa americana especializada na 

produção de soluções para a área de informações geográficas e líder mundial em sistemas de 

informação geográfica, SIG pode ser resumida a duas palavras: tecnologia e ciência. Ele se 

baseia em uma noção simples de organizar os dados em camadas discretas que são alinhadas, 

i.e. georreferenciadas, em relação umas às outras no espaço geográfico (The ARCGIS Book, 

2017). 
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Ademais, SIG pode ser também descrita como: “um conjunto manual ou 

computacional de procedimentos utilizados para armazenar e manipular dados 

georreferenciados” (ARONOFF, 1989); “conjunto poderoso de ferramentas para coletar, 

armazenar, recuperar, transformar e visualizar dados sobre o mundo real” (BURROUGH, 

1986); “um sistema de suporte à decisão que integra dados referenciados espacialmente num 

ambiente de respostas a problemas” (COWEN, 1988); “um banco de dados indexados 

espacialmente, sobre o qual opera um conjunto de procedimentos para responder a consultas 

sobre entidades espaciais” (SMITH et al., 1987); "um sistema constituído por um conjunto de 

programas computacionais, o qual integra dados, equipamentos e pessoas com o objetivo de 

coletar, armazenar, recuperar, manipular, visualizar e analisar dados espacialmente 

referenciados a um sistema de coordenadas conhecido" (EASTMAN, 1995 apud FITZ, 2008, 

p. 23). Em suma, SIG são ferramentas computacionais de geoprocessamento, que permitem a 

realização de “análises complexas, ao integrar dados de diversas fontes e ao criar bancos de 

dados georreferenciados” (CÂMARA et. al., 2005). 

As principais características de um SIG são, portanto: “integrar, numa única base de 

dados, informações espaciais provenientes de dados cartográficos, dados de censo e de 

cadastro urbano e rural, imagens de satélites, redes, dados e modelos numéricos de terrenos; 

combinar as várias informações, através de algoritmos de manipulação, para gerar 

mapeamentos derivados; consultar, recuperar, visualizar e imprimir o conteúdo da base de 

dados geocodificados”. Portanto, há pelo menos três grandes maneiras de utilizar um SIG: 

como ferramenta para produção de mapas; como suporte para análise espacial de fenômenos; 

como um banco de dados geográficos, com funções de armazenamento e recuperação de 

informação espacial (CÂMARA, 1993; CÂMARA et al, 2001; IBRAHIN, 2016). 

De acordo com Câmara et al. (2001), pode-se indicar que um SIG tem cinco 

componentes: (i) interface com usuário; (ii) entrada e integração de dados; (iii) funções de 

consulta e análise espacial; (iv) visualização e plotagem; (v) armazenamento e recuperação de 

dados. Na Figura 9, é possível ver a relação dos cinco componentes de um SIG. 
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Figura 9: Estrutura Geral de Sistema de Informação Geográfica 

Fonte: Câmara et al (2001) 

Contudo, para Fitz (2008), um SIG é essencialmente composto por cinco 

componentes: (i) hardware como o computador, (ii) software como o aplicativo, programa ou 

suporte operacional, (iii) interface como dispositivo visual para desenvolvimento da 

informação, (iv) banco de dados como informações, elementos ou registros inseridos de modo 

padronizado em relação à análise ou ao estudo que está sendo realizado; e (v) usuários e 

analistas como profissionais, pesquisadores e estudante. Já para Ibrahin (2016), o SIG é 

composto apenas por quatro elementos: (i) dados geográficos de informação; (ii) hardware; 

(iii) software; e, (iv) recursos humanos. 

Para utilizar um SIG, é necessário a transformação de conceitos reais em 

representações computacionais por cada especialista envolvido num estudo geográfico, 

tornando viável, assim, o compartilhamento dos dados do estudo com outros especialistas de 

diferentes disciplinas. Em outras palavras, o espaço comumente discutido em uma análise 

utilizando o SIG são espaços computacionalmente representados e não aos conceitos abstratos 

de espaço geográfico. Portanto, o termo Sistemas de Informação Geográfica (SIG) é aplicado 

para sistemas que realizam o tratamento computacional de dados geográficos e recuperam 

informações não apenas com base em suas características alfanuméricas, mas também através 

de sua localização espacial. Para que isto seja possível, a geometria e os atributos dos dados 

num SIG devem estar georreferenciados, isto é, localizados na superfície terrestre e 

representados numa projeção cartográfica (CÂMARA et al, 2001). 
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Na Figura 10 abaixo, resume-se o conceito de SIG, em que o mundo real é 

simplificado e representado por dados provenientes das geotecnologias e das informações 

coletadas; esses dados são manipulados, armazenados e editados de acordo com o interesse do 

usuário, permitindo o desenvolvimento de análises espaciais (IBRAHIN, 2016). 

 

 

Figura 10: Conceito de SIG 

Fonte: Ibrahim (2016) 

O Sistema de Informações Geográficas - SIG utiliza informações espaciais sobre o que 

está ou ocorre na superfície terrestre. Para Ibrahin (2016), a obtenção desses dados 

geográficos pode ocorrer por meio de quatro maneiras: (i) digitalização; (ii) base de dados; 

(iii) GPS; e/ou, (iv) sensoriamento remoto. 

a) Digitalização: processo de transferência de dados em papel (mapas ou fotos) para a 

forma digital; 

b) Base de dados: conjunto de dados logicamente relacionados e com algum significado; 

c) Sistema de Posicionamento Global - GPS: sistema de navegação por satélite que 

fornece a um receptor móvel a posição individual no globo terrestre; 

d) Sensoriamento remoto: reconhecimento e identificação de objetos, sem o contato 

físico com eles, em que satélites e aviões são as plataformas mais usadas. 

 

Os dois principais tipos de dados armazenados em um SIG são os gráficos, 

representados pela Figura 11 e dados alfanuméricos, representados pela Tabela 2. Esses 

dados, assim, são armazenados e manipulados em um sistema de gerenciamento de banco de 

dados - SGBD por meio de cinco etapas principais e diretamente vinculadas ao SIG: (i) 

aquisição de dados; (ii) armazenagem de dados; (iii) edição de dados; (iv) recuperação; e, (v) 

representação de dados (Fitz, 2008). 
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Figura 11: Representação de Dado Gráfico – imagem raster e feições vetoriais 

Fonte: Adaptado de Meneses e Almeida 

 

Tabela 2: População residente, por situação do domicílio sexo e idade, segundo a condição do domicílio 

 

Fonte: IBGE (2010) 

 

Contudo, a representação do mundo real, i.e. a representação desses dados gráficos e 

alfanuméricos, podem ser de dois formatos: matricial (ou raster) ou vetorial. Para Câmara et 

al (2001), uma representação vetorial apresenta o relacionamento topológico entre objetos 

disponíveis através de um armazenamento por coordenadas, seja por pontos, linhas e/ou 

polígonos; já uma representação matricial (ou raster) apresenta o relacionamento espacial 

através de inferências realizadas em matrizes.  

No modelo matricial, também denominado como raster, há uma matriz de células às 

quais estão associadas a valores que possibilitam reconhecer o objeto sob a forma de imagem 

digital. As imagens representadas por uma matriz M(i,j) são compostas por i colunas e j 
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linhas, que definem células, denominadas pixels (picture cell) ao se cruzarem. Cada pixel 

representa uma área no terreno e apresenta um valor, objeto ou condição que é encontrado na 

localização, bem como valores que definem o número da coluna e o número da linha, 

correspondendo às coordenadas x e y (IBRAHIN, 2016). Portanto, conforme Lisboa Filho e 

Iochpe (1996, p. 24), no modelo matricial, "as entidades estão associadas a grupos de células 

do mesmo valor; o valor armazenado em uma célula representa a característica mais marcante 

da variável em toda a área relativa à célula”.  

No modelo vetorial, os pontos são representados por um vértice, ou seja, por apenas 

um par de coordenadas que define a localização de objetos que não apresentam área nem 

comprimento; ou seja, são representações espaciais armazenadas em um banco de dados 

geográfico e cuja dimensão, geralmente, não se modifica conforme a variação de grande e 

pequena escala, segundo Lisboa Filho e Iochpe (1996). As linhas poligonais ou arcos são 

representadas pelo menos por dois vértices ligados que geram polígonos abertos e expressam 

elementos que têm comprimento, como estradas, rios, avenidas, pontes etc. Os polígonos são 

representados por pelo menos três vértices conectados, sendo que o primeiro vértice possui 

uma coordenada idêntica à do último, gerando polígonos fechados que definem elementos 

geográficos com área e perímetro; ele é utilizado para a definição de limites como uso e 

cobertura do solo, limites político-administrativos dos municípios e estados, por exemplo 

(Ibrahin, 2016). Portanto, no modelo vetorial "a posição de cada objeto é definida por sua 

localização no espaço, de acordo com algum sistema de coordenadas” (Lisboa Filho e Iochpe, 

1996, p. 24). 

 

2.6 Viabilidade Econômica 

 

A viabilidade econômica avalia se um projeto fornece uma contribuição econômica 

líquida geral positiva para a sociedade após a contabilização dos custos e benefícios sociais, 

ambientais e financeiros para a sociedade (IHA, 2020). Para tanto, nesta seção serão descritos 

a definição, as etapas e os critérios da viabilidade econômica. 

 

3.4.1 Definição e importância da Viabilidade Econômica  

 

"Pessoas tomam decisões; os computadores, a matemática e as outras ferramentas, 

não" afirmaram Leland Blank e Anthony Tarquin (2008) em seu livro Engenharia Econômica. 
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Para os autores, as técnicas e os modelos de engenharia econômica auxiliam as pessoas a 

tomarem decisões baseadas em estimativas futuras.  Essas estimativas, como o fluxo de caixa, 

tempo de ocorrência e taxas de juros, podem ser diferentes do que de fato ocorrerá, 

principalmente devido a mudanças nas circunstâncias e a eventos não planejados. Em outras 

palavras, "a natureza estocástica das estimativas provavelmente fará com que o valor 

observado no futuro seja diferente da estimativa feita agora" (BLANK; TARQUIN, 2008). 

Para tanto, uma decisão deve ser tomada em situações de investimentos reais em projetos 

pelos quais se esperam benefícios futuros, pois a alocação e o comprometimento dos recursos 

não podem ser feitos apenas com base na intuição (GOMES, 2013). 

 

3.4.2 Etapas de um estudo de Viabilidade Econômica  

 

Um procedimento importante utilizado para o desenvolvimento e escolha de 

alternativas é o critério para solução de problemas, similar ao apresentado e descrito no tópico 

de Programação Linear. Para Blank e Tarquin (2008), esse procedimento também é aplicável 

a um estudo de viabilidade econômica com diferentes alternativas, em as etapas desse 

procedimento são: (i) entender o problema e definir o objetivo; (ii) coletar dados relevantes; 

(iii) definir as soluções alternativas viáveis e fazer estimativas realistas; (iv) identificar os 

critérios para a tomada de decisões usando um ou mais atributos; (v) avaliar cada alternativa 

por meio da análise de sensibilidade para melhorar a avaliação; (vi) selecionar a melhor 

alternativa; (vii) implementar a solução; (viii) monitorar os resultados.  

"A engenharia econômica tem um papel importante em todas as etapas e é 

fundamental para as etapas 3 a 6. As etapas 2 e 3 estabelecem as alternativas e fazem 

as estimativas correspondentes a cada uma. A etapa 4 exige que o analista 

identifique os atributos para a escolha das alternativas. Isso prepara o cenário para a 

aplicação das técnicas. A etapa 5 utiliza modelos da engenharia econômica para 

concluir a avaliação e para executar quaisquer análises de sensibilidade nas quais 

uma decisão se fundamenta (etapa 6)" (BLANK; TARQUIN, 2008, p.8) 

 

Um outro procedimento é apresentado por Gomes (2013), no seu livro Elaboração e 

análise de viabilidade econômica de projetos, em que seu fluxo lógico é apresentado na Figura 

12 abaixo e seus tópicos são descritos em seguida. 
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Figura 12: Visão Geral das Inter-relações no Processo de Elaboração do Projeto 

Fonte: Gomes (2013) 

 

a) Aplicações: é a lista dos itens dos investimentos a serem feitos no projeto como, por 

exemplo, os itens de investimento de um projeto industrial; i.e. as despesas pré-

operacionais, engenharia, obras civis, equipamentos mecânicos e eletrônicos, 

instalações elétricas, tubulações, montagem e fretes, automação e sistemas, capital de 

giro próprio e contingências; 

b) Fontes de recursos: de onde virão os recursos para viabilizar o projeto, se próprios 

(i.e. acionistas) ou de terceiros e em que proporção; 

c) Quadro de fontes e aplicações: visão dos investimentos e de sua fonte de fundos a 

fim de apresentar o equacionamento, conforme o cronograma de investimentos, entre 

o volume de investimentos necessário em cada período e a origem ou fonte dos 

recursos; 

d) Horizonte do projeto: definir qual será o período de tempo em que serão consideradas 

os custos e benefícios do projeto; i.e. definir a vida útil do projeto, em que se espera 

o retorno do projeto; 

e) Levantamento de receitas e custos: identificação dos custos e benefícios do projeto; 

f) Planilhas de financiamento: para o cálculo dos juros, que são custos operacionais do 

projeto, e das amortizações dos empréstimos, que são consideradas no fluxo de caixa 

do projeto;  

g) Quadro de depreciação: para inclusão da depreciação nos custos operacionais e para 
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apuração do lucro tributável de cada período; 

h) Projeção de resultados: é o demonstrativo de resultados do projeto ao longo do 

horizonte do projeto, fornecendo o lucro líquido estimado em cada período após o 

imposto de renda; e, 

i) Fluxo de caixa: objeto final para análise e avaliação, apresentando em cada período o 

resultado líquido do projeto; i.e. é a diferença entre as entradas e saídas, em que as 

entradas representam o lucro líquido após impostos mais valor de depreciação e 

amortização de despesas operacionais, e as saídas de caixa são constituídas do 

capital próprio, pagamento das parcelas e/ou amortizações dos financiamentos. 

 

Portanto, as etapas do processo de tomada de decisão entre duas alternativas podem 

ser resumidas e descritas na Figura 13 abaixo, em que duas alternativas são exemplificadas: a 

de compra de um equipamento e a de atualização do equipamento antigo. Entende-se como 

alternativa aqui por "opções independentes que envolvem uma descrição sucinta e as 

melhores estimativas dos parâmetros relevantes como, por exemplo, custos de aquisição 

(incluindo preço de compra, desenvolvimento e instalação), vida útil, estimativas das receitas 

e despesas anuais, valor residual (valor de revenda ou trade-in), taxa de juros (taxa de retorno) 

e, possivelmente, efeitos da inflação e do imposto de renda" (Blank & Tarquin, 2008, p.10). 

 

 

Figura 13: Critério de Estudo de Engenharia Econômica 

Fonte: Blank e Tarquin (2008) 
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3.4.3 Critérios de um estudo de Viabilidade Econômica  

 

A análise e avaliação de projetos, para tanto, são feitas com base nos fluxos de caixa 

gerados pelas alternativas levantadas (BLANK; TARQUIN, 2008). Segundo os autores, os 

critérios de análise mais usuais são: (i) valor presente, (ii) período de recuperação do capital, 

popularmente conhecido como payback, e (iii) taxa de retorno. Outros métodos, como o 

método do valor anual uniforme equivalente (ou benefício uniforme equivalente), relação 

custo/benefícios, taxa externa de retorno e taxa interna de retorno modificada, também podem 

ser usados como critérios de seleção de alternativas (TORRES, 2014; ALVES et al., 2017). 

 

3.4.3.1 Valor Presente ou Valor Presente Líquido 

 

O valor presente líquido - VPL, ou simplesmente valor presente, de um projeto é o 

resultado do cálculo na data zero dos fluxos de caixa do projeto, onde a taxa de juros de 

desconto é o custo de oportunidade (i.e. custo de capital) da empresa ou é a taxa de 

atratividade mínima adotada pela empresa para projetos com riscos iguais aos oferecidos pelo 

projeto (Gomes, 2013). Para tanto, o método do VPL, em inglês net present value – NPV, é 

obtido ao se subtrair o investimento inicial de um projeto do valor presente de seus fluxos de 

entrada de caixa (GITMAN; MADURA, 2001). O valor presente líquido mostra o resultado 

econômico do projeto atualizado (ASSAF NETO, 2016).  

Portanto, o critério de decisão é que caso o valor presente seja maior que zero, o 

projeto é aceito e quanto maior for o valor presente, mais desejável é o projeto. Esse critério 

define se o valor presente dos benefícios superará o valor presente dos custos; ou seja, o VPL 

indica quanto o projeto adicionará de recursos à empresa. É importante ressaltar também que 

o método não identifica a taxa mínima de rentabilidade, ou de atratividade - TMA, mas o 

resultado econômico da alternativa financeira (GOMES, 2013). 

 

onde: 

FCj = fluxo de caixa à taxa de juros r no período j, para j = 1, 2, ..., n; 
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n = número de fluxos de caixa;  

r = taxa de juros ou de desconto por período. 

 

As principais vantagens do método do valor presente são: leva em consideração o 

valor do dinheiro no tempo e do custo de capital da empresa (TMA); pode ser aplicado a 

qualquer fluxo de caixa (convencional ou não); e pressupõe a reinversão dos fluxos de caixa à 

TMA. As desvantagens são: exige o conhecimento de diversos parâmetros, principalmente 

uma precisa estimativa dos fluxos de caixa que serão utilizados para análise; é definido em 

termos absolutos (unidades monetárias) ao invés de relativos, não considerando a escala do 

projeto; não considera a vida do projeto, isto é, o prazo de duração de cada projeto; e, por 

último, projetos grandes que envolvem um grande montante de investimento inicial tendem a 

apresentar um VPL superior a projetos menores (ALVES et al., 2017) 

 

3.4.3.2 Período de Recuperação de Capital ou Payback  

 

O período de recuperação do capital, também conhecido por seu termo em inglês 

payback period, é o número de períodos necessários para que seja recuperado o capital 

investido; ou seja, é o número de períodos necessários para que o somatório dos fluxos de 

caixa dos períodos seja igual a zero (GOMES, 2013). Para tanto, o payback é uma forma de 

avaliar a qualidade do investimento através do tempo que esse investimento leva para 

devolver o dinheiro investido, o qual pode ser dividido entre simples ou descontado (Alves et 

al, 2017). O método de cálculo do payback descontado é similar ao utilizado do payback 

simples, bastando trazer ao valor presente os FC e considerar o custo do capital (BRUNI; 

FAMÁ, 2003). O payback, portanto, pode ser calculado mediante a divisão do investimento 

inicial pelo fluxo de caixa que representa o retorno periódico do investimento (SOUZA, 

2014). 

 

Portanto, segundo Gomes (2013), o critério de decisão, tanto para o período de 

recuperação do capital tradicional quanto para o descontado, é de que o projeto é recusado 

caso apresente período de recuperação superior ao limite estabelecido pela empresa. Na 
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seleção entre dois ou mais projetos, quanto menor o período de recuperação, mais desejável é 

a alternativa.  

As principais vantagens do método do período de recuperação de capital, segundo 

Alves et al. (2017) são: simplicidade de cálculo e facilidade de compreensão; fornece uma 

ideia do grau de liquidez e de risco do projeto; em tempos de grande instabilidade, é um 

método que aumenta a segurança nos negócios da empresa. As desvantagens são: não 

considera qualquer taxa de desconto e é independente dos fluxos de caixa gerados depois do 

ano de recuperação. 

 

3.4.3.3 Taxa Interna de Retorno ou Taxa de Retorno 

 

A taxa de retorno, também chamada de Taxa Interna de Retorno - TIR, é a taxa de 

juros que torna o valor presente do projeto igual a zero; em outras palavras, é a taxa de juros 

que torna o valor presente dos benefícios igual ao valor presente dos custos (GOMES, 2013). 

Conforme Alves et al. (2017), a TIR permite encontrar a remuneração do investimento em 

termos percentuais, ou seja, "encontrar a TIR de um investimento é o mesmo que encontrar o 

percentual exato de remuneração que o investimento oferece".  

Vale ressaltar que ao considerar o valor do dinheiro no tempo, o método da TIR 

expressa na verdade a rentabilidade, se for uma aplicação, ou um custo, no caso de um 

empréstimo ou financiamento do FC (ASSAF NETO, 2008). Para tanto, tendo em vista a taxa 

de retorno como aplicação de investimento, o projeto será aceito se ela for maior que seu 

custo de oportunidade; ou seja, em na escolha entre duas ou mais alternativas, é que apresenta 

a maior taxa de retorno (GOMES, 2013). 

 

 

onde: 

VP(i) = valor presente do fluxo de caixa à taxa de juros i na data zero; 

n = número de fluxos de caixa;  

(fcx)j = fluxo de caixa do período j; para j = 0, 1, 2, . . . . ., n;  
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i = taxa de juros por período 

 

As principais vantagens do método da taxa interna, segundo Alves et al. (2017) são: é 

intimamente relacionada ao valor presente líquido; seu cálculo considera o valor do dinheiro 

no tempo; fácil visualização e compreensão por ser em termos percentuais. As desvantagens 

são: maior complexidade em casos não convencionais; e, os fluxos de caixa intermediários 

são reaplicados à taxa do projeto, o que na prática não é verdade sempre.  
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3 METODOLOGIA 

 

O presente trabalho foi realizado através de uma pesquisa quantitativa descritiva com 

enfoque no estudo acadêmico e na análise quantitativa de diferentes cenários de localização 

de ETAs dentro do programa Operação Carro-Pipa - OCP. Para tanto, o estudo pode ser 

dividido em duas frentes principais: a pesquisa operacional via modelagem para a solução de 

um problema de programação linear, e o geoprocessamento via SIG para a solução de um 

problema de análise ponderada.  

Para Hillier e Lieberman (2013), como já descrito, um estudo de pesquisa operacional 

se sintetiza em seis fases gerais: i. definição do problema e coleta de dados, ii. formulação do 

modelo matemático para representar o problema, iii. desenvolvimento de um procedimento 

computacional para derivar as soluções, iv. modelagem de testes, e, por fim, v. 

implementação do modelo. Já para Pontuschka e Albuquerque (2012), um estudo de 

geoprocessamento pode ser interpretado através de três etapas: i. coleta e armazenamento de 

dados, ii. tratamento e análise de dados, e iii. uso integrado.  

Portanto, para o desenvolvimento de um modelo de otimização de rotas e localização 

de ETAs, têm-se as seguintes etapas do trabalho em questão.  

 

3.1 Definição do problema em questão  

 

Identificado como uma das regiões brasileiras com o nível de estresse hídrico 

extremamente alto, o Nordeste sofre com o crescimento da demanda hídrica apresentando o 

maior percentual de sedes e populações com algum grau de vulnerabilidade dos mananciais 

(FAO, 2016; Atlas Águas da Ana, 2020).  Para tanto, como abastecimento emergencial e/ou 

medida reativa do Governo Federal, a Operação Carro-Pipa é responsável pelo transporte de 

água para mais de 600 municípios brasileiros, como já descrito; assim, o programa visa 

distribuir a água ofertada pelos mananciais - MAN e demandada pelas prefeituras 

administrativas - PA dos Estados nordestinos do Brasil. 

O CENAD verificou, portanto, a oportunidade de melhorias nas rotas de distribuição 

dos carros-pipa visto que algumas rotas eram mais custosas para a operação como, por 

exemplo, o MAN1 transportava água para o PA1 sendo que era mais próxima do PA2. Para 

tanto, a fim de encontrar soluções ótimas para o abastecimento hídrico, foi adotada a técnica 
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da programação matemática para resolver um problema de transporte de água, 

especificamente de Programação Linear e Inteira. 

Ademais, após a otimização das rotas da OCP e geração de economia ao programa, 

foram identificados e explorados novos cenários para redução de custos da Operação Carro-

Pipa; uma oportunidade de estudo é, e foi, a otimização da localização de estações de 

tratamento de água - ETAs no Nordeste. Assim, verificou-se aqui uma outra oportunidade de 

melhorias, porém agora de localização geográfica e de suporte para análise ponderada 

espacial de fenômenos; sendo assim, uma oportunidade de estudo da ciência da 

geoinformação para implementação e representação do espaço geográfico. 

Portanto, o presente trabalho foi resultado de uma demanda de um projeto anterior do 

CENAD em parceria com o Laboratório de Pesquisa Operacional da Engenharia de Produção 

da Universidade de Brasília - UnB, a fim de incrementar novos pontos de ofertas, ou seja, as 

ETAs, à modelagem de rotas da operação.  

 

3.2 Coleta, armazenamento e implementação de dados 

 

Para a realização do estudo, foi necessária a coleta não só dos dados referentes a OCP, 

como os dados de oferta e demanda de água e as distâncias entre os pontos de oferta - MAN - 

e demanda de água - PA - mas também novas informações para sustentação da análise 

ponderada dos fenômenos relacionados à produção, consumo e distribuição de água. Para 

tanto, os seguintes dados foram coletados e implementados no estudo: 

a) Latitude e longitude dos mananciais e das prefeituras administrativas: fornecidos pelo 

CENAD e tratados com as ferramentas do ArcGIS; 

b) Latitude e longitude das novas estações de tratamento de água: obtidos e tratados 

através das ferramentas do ArcGIS; 

c) Oferta e demanda de água calculados em quantidade de carros-pipa: fornecidos pelo 

CENAD e tratados na modelagem matemática e computacional de rotas; 

d) Matriz de distâncias entre MAN e PA: obtidos e tratados através das ferramentas do 

ArcGIS; 

e) Oferta e demanda de água por forma de abastecimento: fornecidos e coletados pela 

Pesquisa Nacional de Saneamento Básico do IBGE; 

f) Oferta e demanda de água por tipo de tratamento: fornecidos e coletados pela 
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Pesquisa Nacional de Saneamento Básico do IBGE; 

g) Mapa de estresse de água: fornecidos e coletados pela Organização das Nações 

Unidas para a Educação, Ciência e Cultura; e, 

h) Rotas de transporte por estradas e rodovias: fornecidos pelo o OpenStreetMap - OSM 

e tratados através das ferramentas do ArcGIS. 

 

3.3 Formulação de um modelo matemático para representar o problema 

 

Construído para um estudo de pesquisa operacional - ou seja, para o problema de 

transportes da água em questão -, o algoritmo matemático se classifica como um problema de 

programação linear em que objetiva minimizar os custos de distribuição hídrica do Estado do 

Ceará a partir de informações de oferta dos mananciais e de demanda das prefeituras. Para 

tanto, no problema em questão, o custo de distribuição é diretamente proporcional à distância 

percorrida entre os pontos de oferta e demanda frente ao custo intrínseco da gasolina dos 

carros-pipa na operação.  

Ademais, como descrito pelo Governo Federal, existe também a representatividade da 

distância pela Unidade de Medida de Transporte - UMT usada para cálculo da remuneração 

para os carros-pipa.  

“Para se ter um critério único de avaliação de preço e medição dos serviços 

prestados, a Unidade se Medida de Transporte (UMT) a ser utilizada na Operação 

deverá ser a seguinte: - Volume Transportado (V) x Distância do Manancial ao 

Ponto de Distribuição (D) x Quantidade de Viagens Realizadas (Q) x Índice 

Multiplicado (I), ou seja, UMT=V x D x Q x I, cujo produto final fica 

convencionado denominar-se MOMENTO DE TRANSPORTE” (Diário Oficial da 

Casa Civil, 2021) 

 

Outro ponto importante é a restrição da Operação Carro-Pipa frente ao controle de 

rotas entre os mananciais e as prefeituras. Para a OCP, existe apenas um ponto de oferta para 

cada ponto de demanda, ou seja, cada PA é atendido exclusivamente por um MAN como, por 

exemplo, o PA1 não pode receber água do MAN1 e MAN2, o PA1 só recebe água do MAN1. 

Portanto, considerando as capacidades de oferta Ci, os valores de demanda Ej e a distâncias 

entre seus pontos Dij, o formato da modelagem se transforma em:  
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3.4 Desenvolvimento de um modelo computacional para derivar as soluções 

 

Para derivações das soluções, foram utilizadas duas ferramentas: a linguagem de 

programação, Python, com apoio de um aplicativo web open-source, e o software ArcGIS.  

Python foi utilizado para modelagem do problema de otimização das rotas, em que as 

bibliotecas Pandas e PuLP foram importadas e usadas para resolução do problema de 

programação linear (vide



66 

 

ANEXO A – Código para resolução do modelo de Programação Linear). Já o ArcGIS foi 

empregado para gerar as matrizes de distâncias, que eram inputs para a modelagem, e também 

para análise ponderada dos fenômenos espaciais, em que as ferramentas computacionais 

principais usadas foram o Generate Origin-Destination Cost Matrix e Weighted Overlay (vide 

ANEXO C – Passo a passo das ferramentas Weighted Overlay e Generate O/D Matrixs). 

 

3.5 Modelagem de testes e implementação 

 

Para validação do modelo, o processo de teste e aperfeiçoamento do modelo de PL foi 

realizado em diversos momentos durante a revisão do código de otimização de rotas como, 

por exemplo, a verificação dos dados de entradas, das linhas de código e principalmente das 

saídas geradas a cada linha pela biblioteca PuLP. Já, para validação e consistência dos 

resultados gerados pelo ArcGIS, foi observado, acompanhado e evitado ao longo do 

tratamento de dados cada alerta automático e indesejado do software. 

Definidos as ferramentas e os processos a serem seguidos, o modelo computacional foi 

implementado em diferentes momentos do estudo em questão com o objetivo de minimizar os 

custos e encontrar os ganhos de rotas; enquanto a análise de geoprocessamento foi usada em 

dois momentos principais: o momento de gerar a matriz de distâncias com o objetivo de 

consolidar os inputs da modelagem, e o de analisar ponderadamente o espaço geográfico com 

o objetivo de encontrar a localização ótima das ETAs. 

 

3.6 Análise e uso integrado dos dados 

 

Para análise dos cenários obtidos, foram utilizados indicadores econômicos para 

avaliar a viabilidade econômica de cada cenário e assim escolher o melhor cenário de 

localização da estação de tratamento de água dentre os critérios e as premissas do trabalho em 

questão. Já, para integração dos dados, dois passos e outros procedimentos, como o de extrair 

os dados do ArcGIS em formato de matriz (vide ANEXO B – Código para exportar matrizes), 

foram desenvolvidos para melhor manuseio dos dados.  

Ademais, a Figura 14 resume a integração dos dados, descrevendo de forma intuitiva 

um macroprocesso, com entradas, processos de transformação e saídas, para análise das 

melhores localidades para implementação de uma estação de tratamento.  de água. é 
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importante mencionar que os detalhes de cada macroprocesso, o de Geoprocessamento e o de 

Modelagem, são descritos nos ANEXO C e A, respectivamente. 

 

Figura 14: Integração dos Dados do Estudo 

Fonte: Autoria Própria (2021) 
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4 DESENVOLVIMENTO 

 

No desenvolvimento do trabalho em questão, foi definido o problema a ser estudado e 

os dados necessários para o andamento do projeto; além disso, foram construídos e definidos 

diferentes cenários de localização de ETAs na área de estudo para, posteriormente, avaliar a 

economia gerada nas rotas de cada cenário idealizado, relativa ao cenário-base. Para tanto, 

nesta seção, serão apresentados a motivação, a área de interesse, as ferramentas e o passo a 

passo de desenvolvimento do estudo em questão. 

 

4.1 Definição do problema e coleta de dados  

 

O presente trabalho, como já mencionado, foi resultado de uma demanda de um 

projeto anterior do CENAD em que as rotas da OCP de todos os estados nordestinos foram 

otimizadas por Garcia et al. (2019). Para tanto, a fim de gerar maiores economias com maior 

produção de água, foi decidido analisar a melhor localização das estações de tratamento de 

água para o Estado do Ceará, em que a economia resultante no estudo inicial foi de 6,20% 

(Garcia et al, 2019). 

Para a modelagem de rotas, os dados de localização (i.e. latitude e longitude), de oferta 

e de demanda foram fornecidos pelo CENAD. Ademais, foi utilizado do geoprocessamento 

com apoio do software ArcGIS e de dados da malha rodoviária brasileira para gerar as 

matrizes de distâncias (vide ANEXO C – Passo a passo das ferramentas Weighted Overlay e 

Generate O/D Matrix). Vale ressaltar que os dados de rodovias, estradas e ruas foram 

coletados pelo projeto open source do OpenStreetMap, o “projeto que cria e distribui dados 

geográficos gratuitos para o mundo” (OSM Wiki, 2021). 

Para a otimização da localização, os dados de produção, consumo e distribuição de 

água foram coletados pela Pesquisa Nacional de Saneamento Básico do IBGE e Relatório 

Anual de Desenvolvimento de Águas da ONU. Contudo, foi necessário realizar alguns ajustes 

aos dados não-tratados do IBGE.  

A partir da Pesquisa Nacional de Saneamento Básico, foi possível mensurar o volume 

de água demandado por município e por forma de abastecimento de água através de duas 

tabelas principais: a Tabela 3218 - Domicílios particulares permanentes, por forma de 

abastecimento de água, segundo a existência de banheiro ou sanitário e esgotamento sanitário, 

o destino do lixo e a existência de energia elétrica, e a Tabela 3451 - Domicílios particulares 
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permanentes, moradores em domicílios particulares permanentes e média de moradores em 

domicílios particulares permanentes, por situação do domicílio. Contudo, para correção e 

adaptação dos dados do IBGE para o ano-base do estudo, foi considerada a correção de 

acréscimo de 1% a.a. no consumo hídrico conforme a análise da AQUASTAT acerca do 

consumo global de água potável, mencionada anteriormente. Portanto, com a quantidade de 

domicílios por municípios, a média de moradores em domicílios por município e a média de 

consumo hídrico no Brasil com as devidas correções, foi possível mensurar a demanda 

volumétrica de água por município e por forma de abastecimento.  

Vale ressaltar que para análise da melhor localização da ETA foram ponderadas 

apenas formas de abastecimento que condizem com a necessidade de uma ETA; para tanto, 

foram desconsiderados os valores demandados de água por uma rede geral, e foram 

consideradas apenas os valores demandados de água por poços, nascentes, rios, açudes, lagos 

e outros. Já, para o volume de água ofertado, foi examinada a Tabela 1773 - Volume de água 

tratada distribuída por dia, total e com existência de tratamento, por tipo de tratamento, em 

que foi filtrada apenas os valores, assim como para a demanda, condizentes para a localização 

de uma ETA; para tanto, foi considerado o volume de água ofertado e tratado apenas por 

meios não-convencionais, simples e até sem tratamentos, e foi desconsiderado o volume de 

água tratado por meios convencionais.  

 

4.2 Definição de diferentes cenários de localização das ETAs via Sistema de 

Informação Geográfico 

 

Após a obtenção e o tratamento dos dados, foram construídos 7 (sete) mapas referentes 

à produção, consumo e distribuição de água para a análise ponderada dos fenômenos espaciais 

e, consequentemente, para identificação de melhores localidades de uma ETA. Para tanto, a 

partir dos dados do IBGE e da ONU, foram desenvolvidas sete camadas diferentes para 

representação intuitiva e espacial de fenômenos relacionados ao problema da água no Estado 

do Ceará. As camadas construídas foram:  

a) Duas camadas de distância euclidiana, usando dados de localização do CENAD e 

ferramentas do ArcGIS; 

b) Uma camada de estresse de água, usando dados de estresse hídrico da ONU e 

ferramentas do ArcGIS; 

c) Duas camadas de ganho de otimização, usando dados de otimização das rotas da 
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situação atual e ferramentas do ArcGIS; 

d) Uma camada de volume demandado, usando dados do IBGE e ferramentas do 

ArcGIS; e,  

e) Uma camada de volume ofertado, usando dados do IBGE e ferramentas do ArcGIS. 

 

Assim, para cada informação obtida e tratada, foram construídas camadas para a 

representação espacial desses fenômenos conforme apresentados nas Figuras 15 a 21 e 

seguindo o passo a passo do ANEXO C – Passo a passo das ferramentas Weighted Overlay e 

Generate O/D Matrix. 

 

 

Figura 15: Mapa de Distâncias Euclidianas entre Mananciais  

 Figura 16: Mapa de Distâncias Euclidianas entre Prefeituras Administrativas 

Fonte: Autoria própria 
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Figura 17: Mapa de Estresse de Água 

Fonte: Autoria Própria 

 

 

Figura 18: Mapa de Ganho de Otimização por Mananciais 

Figura 19: Mapa de Ganho de Otimização por Prefeituras Administrativas 

Fonte: Autoria Própria 



72 

 

 

Figura 20: Mapa de Volume Demandado 

Figura 21: Mapa de Volume Ofertado 

Fonte: Autoria Própria 

 

Finalizada a construção dos mapas, foi então realizada a análise ponderada desses 

fenômenos espaciais para a escolha de diferentes cenários de localização da ETA. Para tanto, 

a fim de identificar essas localidades, performou-se a análise de peneiramento utilizando 

múltiplas camadas (NOBLE, 1992; KUTA et al., 2016 apud QUARESMA, 2021). A 

ferramenta principal usada para tal análise foi a Weighted Overlay do ArcGIS em que os 

critérios de peso para cada camada foram: 

a) 20% para os mapas de distância euclidiana; 

b) 10% para o mapa de estresse de água; 

c) 15% para os mapas de ganho de otimização; 

d) 10% para o mapa de volume demandado; e,  

e) 10% mapa de volume ofertado. 

 

Vale ressaltar que para todas as camadas os valores foram uniformemente agrupados, 

porém para cada camada uma simbologia diferente foi empregada. Para as camadas de 

estresse (B) e ganho (C), volume (D e E), quanto maior seu valor maior a necessidade de uma 
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ETA e, consequentemente, uma melhor localização de ETA. Já para a distância euclidiana 

(A), em particular dos MANs, quanto menor seu valor maior a necessidade de uma ETA e, 

consequentemente, uma melhor localização de ETA. Ademais, as camadas com os dados por 

localizações mais agregadas como, por exemplo, os dados por municípios e por regiões 

maiores apresentaram menor peso no momento de decisão para localização das ETAs, 

considerando assim maior influência dos dados de ganhos e distâncias dos mananciais e das 

prefeituras administrativas. 

Portanto, obtêm-se como resultado da análise as seguintes localidades, representado na 

Figura 22. 
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Figura 22: Mapa das Regiões para Localização das Estações de Tratamento de Água 

Fonte: Autoria Própria 
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4.3 Análise da economia gerada pelos cenários de produção de água e localização das 

ETAs via modelagem e otimização de rotas 

 

Analisados os possíveis cenários de localização de água, foi gerada uma nova matriz 

de distância para esses novos pontos ótimos de oferta, sendo utilizada mais uma vez como 

input do modelo de otimização de rotas. Os cenários construídos contaram com 9 pontos de 

localização e 3 tamanhos diferentes de ETA, influenciando na quantidade de água produzida e 

tratada por cada cenário construído para análise; totalizaram, assim, 54 cenários de produção, 

distribuição e consumo de água no Estado cearense. Para tanto, após a construção das 

matrizes e a otimização das rotas para cada cenário de localização de ETA, foi feita então uma 

análise de economia positiva desses diferentes cenários. O acréscimo de uma ETA no cenário 

de transporte de água no OCP pode e deve gerar mais economia ao programa frente ao custo 

inicial de instalação, implementação e operação de uma ETA no programa.  

Primeiramente, para implementação do modelo via Python, é necessária a compressão 

inicial dos dados de entrada e de saída da modelagem computacional; assim, entende-se por: 

a) Dados de entradas: 

− df_oferta_final: id_oferta, oferta - identificação do manancial ou ETA, 

capacidade de oferta de água por quantidade de carros-pipa 

 

Tabela 3: Exemplo dados de oferta 

id_oferta oferta 

33 188 

148 89 

601 94 

646 1 

... ... 

2722 1 

Fonte: Autoria própria (2021) 

 

− df_demanda_final: id_demanda, demanda - identificação da prefeitura 

administrativa, valor demandado por quantidade de carros-pipa 
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Tabela 4: Exemplo dados de demanda 

id_demanda demanda 

1 9 

2 7 

3 1 

4 1 

... ... 

4599 1 

Fonte: Autoria própria (2021) 

 

− df_distancias_final: [PA, MAN] - matriz de distâncias entre as prefeituras e os 

mananciais, ou ETAs, populado com os valores de distâncias em metros 

 

Tabela 5: Exemplo de dados de distâncias 

33 148 601 646 1192 1241 

239610 205663 137995 398104 114551 220546 

266807 232860 178188 328581 104168 153713 

458952 425005 370333 195233 201411 61512 

478198 444251 389579 140191 220658 80758 

... ... ... ... ... ... 

384601 293634 210568 436182 270864 284614 

Fonte: Autoria própria 

 

a) Dados de transformação: 

− prob = LpProblem('Otimizacao_CE_Cenário_Atual', LpMinimize):): 

definindo o problema de programação linear 

− Varx = LpVariable.dicts('Varx', [(MAN,PA) for MAN in 

range(len(oferta)) for PA in range(len(demanda))], 0, None, 

LpInteger): definindo as variáveis de decisão 

− prob += lpSum([demanda[PA] * distancias.iloc[MAN, PA] * Varx[MAN, 

PA]   for PA in range(len(demanda)) for MAN in 

range(len(oferta))]): definindo a função objetivo do problema 

− for MAN in range(len(oferta)): 
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prob += lpSum([Varx[MAN,PA] * demanda[PA] for PA in 

range(len(demanda))]) <= oferta[MAN] 

for PA in range(len(demanda)):     

prob += lpSum([Varx[MAN,PA] for MAN in 

range(len(oferta))]) == 1 

: definindo as restrições do problema 

b) Dados de saída: 

− print('A Km final total e de: '+str(value(prob.objective))+' m') 

print('A Km final total e de: 

'+str((value(prob.objective))/1000)+' Km') 

: distância total em metros e quilômetros 

− resultados_excel e resultados_csv: variável, valor - rota entre MAN, PA e valor 

 

Figura 23: Exemplos de Resultados em Formato CSV 

Fonte: Autoria própria 

 

Na Tabela 3, é possível identificar a capacidade de oferta de 188 carros-pipa do MAN 

33; na Tabela 4, por exemplo, o valor demandado da PA 1 são 9 carros-pipa; e, na Tabela 5, a 

distância entre o PA1, na linha 1, e o MAN33 é de 239,610 metros.  

Para os dados de transformação, em primeiro lugar, foi definido um problema de 

minimização frente ao objetivo do trabalho em questão e, depois, as variáveis de decisão, a 

função objetivo e as restrições do problema foram definidos. Vale ressaltar que as variáveis de 

decisão, xij, correspondem a uma decisão binária de rota, a qual assume valor 1 quando o 

MAN i atende o PA j e assume 0 no caso contrário, i.e. o MAN i não atende o PA j. Contudo, 

apesar do problema ser definido como inteiro e não binário, isso ocorre pois as restrições de 
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demanda para cada PA totaliza 1; ou seja, por exemplo: x1,1 + x2,1 + x3,1 + x4,1 + ... + x36,1 = 1 . 

O problema de PO, então, se define e é caracterizado como um problema de Programação 

Linear e Inteiro.  

Ademais, existem dois dados de saída. O primeiro informa a metragem e 

quilometragem total das rotas da OCP para o Estado do Ceará; e, o segundo, indicando qual 

manancial serve para qual prefeitura administrativa, onde cada linha do arquivo assume valor 

0 ou 1, como mencionado, para cada par de MAN para o PA.  

Em segundo, para maior correspondência das análises, foi aplicada a otimização de 

rotas via modelagem para a situação atual do Estado do Ceará devido à coleta dos dados de 

rodovias e ruas do trabalho em questão ter sido realizada no ano de 2021, e o estudo inicial 

em 2019. O cenário da situação atual será convocado como cenário-base a partir de agora e 

foi construído considerando 36 MANs e 4599 PAs. O resultado desse cenário, após a 

aplicação da modelagem, foi de 1,061,493.18 km.  

Em terceiro, foram otimizados mais 54 cenários. Os primeiros 27 deles são referentes 

a cenários de acréscimo de 1 ponto de localização (i.e. uma ETA), dentre os 9 novos pontos 

de oferta, com 3 diferentes alternativas de tamanho e produção de água (9*3 = 27). Para tanto, 

foi considerada para o trabalho três capacidades divergentes de uma ETA; são elas: ETA 

móvel com capacidade de tratamento de 75,000 litros de água por dia (Filgueira, 2017), ETA 

fixa pequena com capacidade de 200,000 litros por dia e ETA fixa média com capacidade de 

670,000 litros por dia (QUARESMA, 2021). Contudo, vale ressaltar que, para a modelagem, 

foi considerada a capacidade 113, 300 e 1000 carros-pipa para cada cenário de localização e 

produção de ETA devida a capacidade de entrega de um carro-pipa de 20,000 litros. Os outros 

27 cenários foram construídos a partir da combinação de 2 ETAs e 9 alternativas de 

capacidades combinadas de água tratada, onde as ETAs eleitas e escolhidas para tais 

combinações apresentaram maior economia dentre os primeiros 27 cenários analisados. Vale 

ressaltar que as combinações feitas consideraram a distância entre as ETAs, não combinando 

ETAs muito próximas.  

Na Tabela 6, é possível visualizar as informações de localização, alternativas de 

produção de água, a quilometragem total otimizada e a economia gerada para os 54 cenários 

construídos com base nas 9 diferentes localidades de ETAs, nas 3 capacidades de produção de 

água tratada, nas 3 combinações de ETAs e nas 9 combinações de produção de água. 
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Tabela 6: Economia gerada em porcentagem dos cenários construídos 

ETA Longitude (X) Latitude (Y) Cenário Oferta ETA 
Quilometragem 

Total (Km) 
Economia (%) 

-   Atual - 1061493,182 - 

111111 -39,353254 -7,273325 

Cenário 1 113 1061493,182 0 

Cenário 2 300 1061493,182 0 

Cenário 3 1000 1061493,182 0 

222222 -40,772179 -5,53617 

Cenário 4 113 1054605,308 0,6488853736 

Cenário 5 300 1049416,099 1,137744755 

Cenário 6 1000 1038722,198 2,145184198 

333333 -38,112951 -5,191166 

Cenário 7 113 1061468,21 0,00235253512 

Cenário 8 300 1061468,21 0,00235253512 

Cenário 9 1000 1061468,21 0,00235253512 

444444 -39,72 -7,17 

Cenário 10 113 1058545,699 0,2776732861 

Cenário 11 300 1054805,698 0,6300072495 

Cenário 12 1000 1053976,724 0,7081023343 

555555 -40,7 -4,52 

Cenário 13 113 1056833,299 0,4389932106 

Cenário 14 300 1050718,525 1,015047217 

Cenário 15 1000 1045773,373 1,48091474 

666666 -39,3 -7,04 

Cenário 16 113 1060011,62 0,1395733882 

Cenário 17 300 1057621,099 0,3647770015 

Cenário 18 1000 1057068,312 0,4168533604 

777777 -38,55 -4,04 

Cenário 19 113 1059633,236 0,1752197783 

Cenário 20 300 1059633,236 0,1752197783 

Cenário 21 1000 1059633,236 0,1752197783 

888888 -39,53 -3,51 

Cenário 22 113 1057241,966 0,4004939525 

Cenário 23 300 1053289,335 0,7728591327 

Cenário 24 1000 1051063,974 0,9825035315 

999999 -39,23 -7,02 

Cenário 25 113 1060677,959 0,07679964543 

Cenário 26 300 1059738,492 0,165303935 

Cenário 27 1000 1059509,647 0,1868627169 
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ETA Longitude (X) Latitude (Y) Cenário Oferta ETA 

222-222 + 444-444 

Cenário 28 113 e 113 1051657,825 0,9265586597 

Cenário 29 113 e 300 1047917,824 1,278892623 

Cenário 30 113 e 1000 1047088,85 1,356987708 

Cenário 31 300 e 113 1046468,616 1,415418041 

Cenário 32 300 e 300 1042728,615 1,767752004 

Cenário 33 300 e 1000 1041899,641 1,845847089 

Cenário 34 1000 e 113 1035774,715 2,422857484 

Cenário 35 1000 e 300 1032034,714 2,775191447 

Cenário 36 1000 e 1000 1053123,746 0,7884587619 

222-222 + 666-666 

Cenário 37 113 e 113 1053123,746 0,7884587619 

Cenário 38 113 e 300 1050733,225 1,013662375 

Cenário 39 113 e 1000 1050180,438 1,065738734 

Cenário 40 300 e 113 1047934,537 1,277318143 

Cenário 41 300 e 300 1045544,016 1,502521756 

Cenário 42 300 e 1000 1044991,229 1,554598115 

Cenário 43 1000 e 113 1037240,636 2,284757586 

Cenário 44 1000 e 300 1034850,115 2,509961199 

Cenário 45 1000 e 1000 1034297,328 2,562037558 

222-222 + 888-888 

Cenário 46 113 e 113 1050354,092 1,049379326 

Cenário 47 113 e 300 1046401,461 1,421744506 

Cenário 48 113 e 1000 1044176,1 1,631388905 

Cenário 49 300 e 113 1045164,883 1,538238707 

Cenário 50 300 e 300 1041212,252 1,910603887 

Cenário 51 300 e 1000 1038986,891 2,120248286 

Cenário 52 1000 e 113 1034468,83 2,545880883 

Cenário 53 1000 e 300 1030526,262 2,917298059 

Cenário 54 1000 e 1000 1028319,254 3,125213479 

Fonte: Autoria própria 

 

Portanto, é possível visualizar que, dentre os primeiros 27 cenários, as ETAs com 

maior ganho de economia - ou seja as ETAs 222-222, 444-444, 666-666 e 888-888 - foram 
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escolhidas para mais 3 possibilidades de cenários de ETAs combinadas (i.e. 222-222 & 444-

444, 222-222 & 666-666 e 222-222 & 888-888) e 9 possibilidades de capacidade de água 

tratada. Para tanto, combinadas em cenários com o acréscimo de 2 novos pontos de 

localização - ou seja, acréscimo de duas ETAS como dois novos pontos de oferta, foram 

aplicadas 9 alternativas diferentes de produção e tratamento de água, fruto da combinação da 

capacidade de água tratada (3*9=27), complemento o estudo com mais 27 cenários. As nove 

possibilidades de produção e tratamento de água são: 

c) ETA móvel e ETA móvel; 

d) ETA móvel e ETA fixa pequena; 

e) ETA móvel e ETA fixa média; 

f) ETA fixa pequena e ETA móvel; 

g) ETA fixa pequena e ETA fixa pequena; 

h) ETA fixa pequena e ETA fixa média; 

i) ETA fixa média e ETA móvel; 

j) ETA fixa média e ETA fixa pequena; e 

k) ETA fixa média e ETA fixa média. 
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5 RESULTADOS 

 

Nesta seção, serão apresentados os resultados obtidos da viabilidade econômica dos 

cenários com melhores economias, geradas na modelagem de rotas.  

Após a construção e modelagem de rotas dos cenários construídos, foi realizado um 

estudo da viabilidade econômica de três cenários de localização daqueles com maior ganho de 

economia dentre os primeiros 27 cenários, e um cenário, dentre os últimos 27 cenários. São 

eles: 222-222, 555-555, 888-888 e 222-222 & 888-888, os quais são apresentados na Figura 

24 abaixo. 

 

Figura 24: Mapa de Localização das Estações de Tratamento de Água 

Fonte: Autoria Própria (2021) 

 

Considerando o orçamento de 2016 como parâmetro e o custo relativo do Estado do 

Ceará ao programa, entende-se que o Estado em questão representa 12,06% de R$ 

1.021.682.120,57 (QUARESMA, 2021 apud MARDER, 2019; ORTIZ, 2021); para tanto, R$ 

123.214.863,7 da Operação Carro-Pipa são destinados ao Estado cearense. Assume-se para 

viabilidade econômica que a distância é única responsável pelos investimentos destinados à 
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medida emergencial; assim, obtêm-se a economia em reais de cada cenário ao multiplicar a 

economia relativa ao cenário-base e o custo total do Estado para a OCP.  

Para o primeiro cenário, é possível visualizar as economias geradas a partir do custo 

total e o custo otimizado para a ETA 222-222 na Tabela 7 a seguir. 

 

Tabela 7: Economia gerada em reais do Cenário 222-222 

Cenário 1 - ETA 222-222 

Capacidade 
Quilometragem Atual 

(Km) 

Quilometragem 

Otimizada (Km) 
Economia (%) Economia (R$) 

ETA móvel [113] 1.061.493,18 1.054.605,31 0,6489% R$ 799.523,23 

ETA fixa pequena 

[300] 
1.061.493,18 1.049.416,10 1,1377% R$ 1.401.870,65 

ETA fixa média 

[1000] 
1.061.493,18 1.038.722,20 2,1452% R$ 2.643.185,79 

Fonte: Autoria Própria (2021) 

 

De acordo com a Tabela 7, é possível visualizar que, para a ETA 222-222, a economia 

mínima gerada foi de R$ 799.523,23, e a máxima foi de R$ 2.643.185,79.  

Para o segundo cenário, é possível visualizar as economias geradas a partir do custo 

total e o custo otimizado para a ETA 555-555 na Tabela 8 a seguir. 

 

Tabela 8: Economia gerada em reais do Cenário 555-555 

Cenário 2 - ETA 555-555 

Capacidade Custo Atual (Km) 
Custo Otimizado 

(Km) 
Economia (%) Economia (R$) 

ETA móvel [113] 1.061.493,18 1.056.833,30 0,4390% R$ 540.904,89 

ETA fixa pequena 

[300] 
1.061.493,18 1.050.718,53 1,0150% 

R$ 1.250.689,05 

ETA fixa média 

[1000] 
1.061.493,18 1.045.773,37 1,4809% 

R$ 1.824.707,08 

Fonte: Autoria Própria (2021) 
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De acordo com a Tabela 8, é possível visualizar que, para a ETA 555-555, a economia 

mínima gerada foi de R$ 540.904,89, e a máxima foi de R$ 1.824.707,08. 

Para o terceiro cenário, é possível visualizar as economias geradas a partir do custo 

total e o custo otimizado para a ETA 888-888 na Tabela 9 a seguir. 

 

Tabela 9: Economia gerada em reais do Cenário 888-888 

Cenário 3 - ETA 888-888 

Capacidade Custo Atual (Km) 
Custo Otimizado 

(Km) 
Economia (%) Economia (R$) 

ETA móvel [113] 1.061.493,18 1.057.241,97 0,4005% R$ 493.468,08 

ETA fixa pequena 

[300] 
1.061.493,18 1.053.289,34 0,7729% R$ 952.277,33 

ETA fixa média 

[1000] 
1.061.493,18 1.051.063,97 0,9825% R$ 1.210.590,39 

Fonte: Autoria Própria (2021) 

 

De acordo com a Tabela 9, é possível visualizar que, para a ETA 888-888, a economia 

mínima gerada foi de R$ 493.468,08, e a máxima foi de R$ 1.210.590,39. 

Para o quarto cenário, é possível visualizar as economias geradas a partir do custo total 

e o custo otimizado para a ETA 222-222 & 888-888 na Tabela 10 seguir. 

 

Tabela 10: Economia gerada em reais do Cenário 2&8 

Cenário 4 - ETA 222-222 & 888-888 

Capacidade Custo Atual (Km) 
Custo Otimizado 

(Km) 
Economia (%) Economia (R$) 

Móvel e móvel 1.061.493,18 1.050.354 0,4005% R$ 1.292.991,31 

Móvel e fixa 

pequena 
1.061.493,18 1.046.401 0,7729% R$ 1.751.800,56 

Móvel e fixa média 1.061.493,18 1.044.176 1,0494% R$ 2.010.113,62 

Fixa pequena e 

móvel 
1.061.493,18 1.045.165 1,4217% R$ 1.895.338,73 
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Capacidade Custo Atual (Km) 
Custo Otimizado 

(Km) 
Economia (%) Economia (R$) 

Fixa pequena e fixa 

pequena 
1.061.493,18 1.041.212 1,6314% R$ 2.354.147,98 

Fixa pequena e fixa 

média 
1.061.493,18 1.038.987 1,5382% R$ 2.612.461,04 

Fixa média e móvel 1.061.493,18 1.034.468 1,9106% R$ 3.136.903,66 

Fixa média e fixa 

pequena 
1.061.493,18 1.030.526 2,1202% R$ 3.594.544,83 

Fixa média e fixa 

média 
1.061.493,18 1.028.319 2,5459% R$ 3.850.727,53 

Fonte: Autoria Própria (2021) 

 

De acordo com a Tabela 10, é possível visualizar que, para a ETA 2&8, a economia 

mínima gerada foi de R$ 1.292.991,31, e a máxima foi de R$ 3.850.727,53. 

Observa-se que em todos os cenários o maior ganho advém de uma maior capacidade 

de entrega das estações de tratamento de água. Portanto, os cenários de ETAs com capacidade 

de 1000 entregas apresentaram maior economia para a OCP. Contudo, para melhor 

compreensão dos ganhos e custos obtidos pelos cenários e, consequentemente, uma tomada de 

decisão mais assertiva, as principais métricas de avaliação de projetos foram analisadas e 

avaliadas para cada cenário. Vale ressaltar, então, que apesar da economia gerada por cada 

cenário, um retorno financeiro deve ser avaliado frente ao custo de instalação, implementação 

e operação de uma ETA. Portanto, deve-se avaliar a eficiência econômica e financeira para 

demonstrar que o projeto a ser implantado seja viável (HIRSCHFELD, 2000; ROCHA et al., 

2016). 

Segundo o Portal Tratamento de Água (2017), o investimento para a construção de 

uma ETA com capacidade de 53 milhões de litros por dia é de 75,4 milhões de dólares. Ao 

considerar a cotação de câmbio de 5,51 do dia 8 de outubro de 2021, entende-se que o custo 

de implementação de uma ETA de 113, 300 e 1000 entregas é, respectivamente, de: R$ 

885.779,28, R$ 2.351.626,42 e R$ 7.838.754,72. Na Tabela 11 abaixo, é descrito o cálculo 

dos custos de construção de uma estação, os quais foram usados para análise de viabilidade 

econômica. 
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Tabela 11: Custos de implementação de uma ETA por capacidade de entrega dos carros-pipa 

Capacidade  

(em carros-pipa) 

Capacidade  

(litros por dia) 

Capacidade (litros 

por mês) 

Custo de 

implementação (em 

reais) 

ETA móvel [113] 75.000,00 2.260.000,00 R$ 885.779,28 

ETA fixa pequena [300] 200.000,00 6.000.000,00 R$ 2.351.626,42 

ETA fixa média [1000] 670.000,00 20.000.000,00 R$ 7.838.754,72 

referência 53.000.000,00 1.060.000.000,00 R$ 415.454.000,00 

Fonte: Autoria Própria (2021) 

 

Ademais, conforme Silva (2007), os custos envolvidos em um projeto de ETA são os 

custos de investimentos e de operação e manutenção - O&M. Para a autora, entende-se como 

custo de O&M, os custos relativos ao tratamento de água, os quais variam em função da 

tecnologia utilizada, dos gastos com energia elétrica, da qualidade da água bruta dos 

mananciais, das distâncias dos MAN a ETA, do seu uso, da topografia e de outros. Segundo 

Tsutiya (2004), mais de 90% dos gastos com energia elétrica devem-se às elevatórias dos 

sistemas de abastecimento público de água. De acordo com o Programa Nacional de 

Conservação de Energia Elétrica para o Saneamento (PROCEL SANEAR, 2005 apud 

GOMES, 2005), mais de dois por cento do consumo total de energia elétrica do Brasil, o 

equivalente a 7 bilhões de kwh/ano, são consumidos por prestadores de serviços de água e 

esgotamento sanitários. Assim, para os custos de operação e manutenção - O&M, foi 

considerado o custo anual do consumo de energia elétrica, relativo à vazão e capacidade da 

ETA. 

O custo anual do consumo de energia elétrica foi calculado para um intervalo de 

tempo de bombeamento de 8 horas de funcionamento por dia (240 h/mês). Levando-se em 

consideração o conjunto motor-bomba com um rendimento de 70%, e o preço de energia de 

R$ 0,25 por kwh, com a vazão de retorno correspondente a cada alternativa e altura 

manométrica de 6 m.c.a. Para tanto, com base nesses dados, pode-se determinar o custo 

operacional (energia elétrica) para cada alternativa através da seguinte equação. 
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onde: 

Ce = custo de energia elétrica de bombeamento, em R$; 

Q = vazão de retorno, em m3/s;  

p = preço de energia, em R$kwh; 

N = número de horas de funcionamento de recalque por mês; 

H = altura manométrica, em m.c.a; e,  

ƞ = rendimento esperado do conjunto motor-bomba, valor decimal 

 

Na Tabela 12, é possível visualizar o cálculo do custo anual de consumo de energia 

elétrica referente a vazão de cada alternativa de capacidade de ETA. 

 

Tabela 12: Custo anual de consumo de energia elétrica por capacidade de entrega dos carro-pipa 

Capacidade 

Vazão 

corrigida 

(m³/s) 

Altura 

manométrica 

Preço de 

energia 

elétrica 

(R$kwh) 

Tempo de 

funcionamen

to por mês 

(em horas) 

Rendimento 

esperado 

Custo de 

Energia 

Elétrica (R$) 

ETA móvel 

[113] 
0,2604166667 6 0,25 240 0,7 R$ 1313,83 

ETA fixa 

pequena [300] 
0,6944444444 6 0,25 240 0,7 R$ 3503,57 

ETA fixa 

média [1000] 
2,326388889 6 0,25 240 0,7 R$ 11736,9 

Fonte: Autoria Própria 

 
Para tanto, com os valores de economia gerada pelo o modelo de otimização e os 

custos necessários para implementação, instalação e operação das ETAs, foram calculados as 

métricas de payback e valor presente líquido - VPL  de cada alternativa para avaliação do 

retorno financeiro.  

Primeiramente, foi mensurado o número de períodos necessários para que seja 

recuperado o capital investido, ou seja, foi calculado o payback considerando o investimento 

inicial de implementação de ETA e o ganho de economia.  Na Tabela 13, são apresentados os 

resultados de cada cenário.  
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Tabela 13: Payback em meses dos cenários construídos 

Cenário 
ETA móvel 

[113] 

ETA fixa 

pequena [300] 

ETA fixa 

média [1000] 

Duas ETAs 

[mix] 

Descrição do 

mix 

222-222 13 20 35 - - 

555-555 19 22 51 - - 

888-888 21 29 77 - - 

222-222 & 888-

888 

- - - 16 113 e 113 

- - - 22 113 e 300 

- - - 52 113 e 1000 

- - - 20 300 e 113 

- - - 23 300 e 300 

- - - 46 300 e 1000 

- - - 33 1000 e 113 

- - - 34 1000 e 300 

- - - 48 1000 e 1000 

Fonte: Autoria Própria 

 

De acordo com a Tabela 13, conclui-se que o cenário 222-222 em todas suas 

alternativas de capacidade se apresenta como melhor alternativa frente ao seu período de 13 

meses de retorno de investimento para a ETA móvel e 35 meses, para a ETA fixa média. 

Contudo, apesar dos valores de retorno do cenário 2&8 serem maiores quando comparado ao 

cenário 222-222, este apresenta um valor de payback 2 meses maior que o primeiro cenário e 

ainda apresenta maiores benefícios à sociedade cearense já que o cenário conta com o 

acréscimo de duas novas ETAs em diferentes localidades, beneficiando assim uma maior 

parcela da população. 

Vale ressaltar também que todas as alternativas avaliadas apresentaram um período de 

retorno inferior à expectativa de vida de uma ETA. Segundo Fulton (2009), estruturas como 

as estações de tratamento de água têm uma longa expectativa de vida, normalmente sendo 

projetadas com período de vida entre 30 e 50 anos. 
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Em segundo lugar, foi mensurado o valor presente líquido dos cenários construídos. 

Para o método do VPL, foram considerados os fluxos de caixas de cada cenário, os quais o 

ganho de economia e os custos de operação e manutenção foram incluídos. Além disso, foi 

considerado como Custo Médio Ponderado de Capital - WACC (i.e. como taxa de desconto) 

para o cálculo do VPL, o valor de referência de 8,10% a.a. da Agência Reguladora de 

Saneamento e Energia do Estado de São Paulo - ARSESP para o ano de 2020 (ARSESP, 

2020). Na Tabela 14, obtêm-se os resultados obtidos do cálculo do valor presente líquido para 

cada cenário.  

 

Tabela 14: Valor presente líquido – VPL dos cenários construídos  

Cenário ETA móvel [113] 
ETA fixa 

pequena [300] 

ETA fixa média 

[1000] 
Duas ETAs [mix] 

Descrição 

do mix 

222-222 R$ 8.016.166,38 R$ 13.243.514,28 R$ 21.508.199,50 - - 

555-555 R$ 5.131.952,71 R$ 11.557.477,46 R$ 12.380.202,43 - - 

888-888 R$ 4.602.918,73 R$ 8.229.472,39 R$ 5.531.331,09 - - 

222-222 & 888-

888 

- - - R$ 12.619.085,10 113 e 113 

- - - R$ 16.245.638,77 113 e 300 

- - - R$ 13.547.497,50 113 e 1000 

- - - R$ 17.846.433,02 300 e 113 

- - - R$ 21.472.986,70 300 e 300 

- - - R$ 18.774.845,43 300 e 1000 

- - - R$ 26.113.904,11 1000 e 113 

- - - R$ 29.727.430,89 1000 e 300 

- - - R$ 27.005.531,00 1000 e 1000 

Fonte: Autoria Própria 

 

De acordo com a Tabela 14, conclui-se que todas as alternativas são viáveis frente ao 

valor positivo, i.e. VPL > 0, da métrica em questão. Ademais, percebe-se que quanto maior a 

economia gerada com a inclusão da ETA maior o valor de VPL, demonstrando uma 

proporcionalidade direta entre ganho e viabilidade do projeto. Outro ponto importante a ser 
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notado, do cenário 888-888, é que o VPL entre as alternativas de capacidade 300 e 1000 não 

segue essa relação direta visto que a ETA com capacidade de 1000 entregas apresenta um alto 

custo de implementação e de operação e manutenção e uma menor economia relativa dos 

custos de rota, não justificando a implementação de uma ETA fixa média no local quando 

comparada a uma ETA fixa pequena. 
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6 CONCLUSÃO 

 

A água é um item básico para sobrevivência e um direito humano. Muitas ferramentas 

que aliam tecnologia e gestão têm surgido no sentido de viabilizar o acesso ao abastecimento 

de qualidade em regiões vulneráveis. Nesse sentido, o presente trabalho tinha por objetivo 

desenvolver um modelo de otimização de rotas e encontrar a melhor localização de uma ETA 

no estado do Ceará. Para tanto, utilizou-se da modelagem computacional para otimização das 

rotas da Operação Carro-Pipa - OCP, e do geoprocessamento via ArcGIS para processamento, 

integração e análise dos dados geográficos para inclusão de novos pontos de ofertas de água, 

as ETAs. 

Através do geoprocessamento, foram analisados os dados de oferta e demanda de água 

(CENAD), os dados de produção, consumo e distribuição de água (PNSB – IBGE e Relatório 

Anual de Desenvolvimento de Águas da ONU), juntamente com a malha rodoviária da região. 

Feito isso, definiu-se como critérios de localização a distância euclidiana, o estresse de água, 

os ganhos de otimização e os volumes demandado e ofertado, que foram representados 

espacialmente através de mapas. A sobreposição das informações dos mapas juntamente com 

a definição de pesos e critérios para cada um dos parâmetros possibilitou a criação de um 

mapa das melhores localidades para ETA. 

Através da modelagem de rotas, foram gerados e analisados 54 cenários de produção, 

distribuição e consumo de água que levaram em conta a distância entre as ETAs, os 

mananciais e as prefeituras administrativas, o tamanho da estação e a possibilidade de 

implantar uma ou duas estações de tratamento. Essa análise foi confrontada com a realidade 

atual da OCP a fim de analisar a economia gerada pela implementação da obra frente aos 

custos da medida emergencial existente. 

Após as análises, identificou-se os dois cenários considerados mais interessantes para 

resolução do problema de abastecimento Cearense, sendo eles o cenário 222-222 e o cenário 

2&8. O cenário 222-222 conta com a implementação de 1 ETA, que geraria uma economia de 

até R$ 2.643.185,79 para implantação de uma planta fixa média, com capacidade de 

tratamento de 670.000 l/dia ou 1000 carros pipa. Quando considerado o custo do investimento 

frente a economia gerada, o payback do sistema seria de 35 meses. Já o cenário 222-222 & 

888-888 pressupõe a implementação de 2 ETAs de mesma capacidade (670.000 l/dia ou 1000 

carros pipa), gerando uma economia de R$ 3.850.727,53 e um payback de 48 meses. Apesar 
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de possuir um payback mais longo, pode-se afirmar que o segundo cenário é mais vantajoso 

do ponto de vista social à medida que atenderia o dobro da população.  

Ademais, considerando que uma ETA possui vida útil de até 50 anos, a diferença do 

payback entre os cenários representaria uma porcentagem ínfima (3,1%) da vida útil da 

planta, que ainda geraria economia por muito tempo. Para tanto, considerando os problemas 

sociais que acometem a região do nordeste pela falta de água tratada, como doenças 

gastrointestinais e mortalidade infantil, entende-se que os custos de implementação e 

operação de uma ETA se justificam tanto economicamente quanto socialmente e 

ambientalmente, frente a sua característica intrínseca de preservação de vidas. O investimento 

em saneamento básico gera um retorno 4,3 vezes maior através da economia em saúde pública 

(UN, 2014).  

Conclui-se então, após análise da viabilidade econômica dos cenários, que a 

construção de uma ETA nas devidas localidades é viável economicamente. Ademais, é 

importante mencionar também os benefícios ambientais e sociais gerados por uma estação de 

tratamento de água em uma região de um alto estresse hídrico, em que a saúde e o cotidiano 

de milhares de brasileiros são aprimorados. 
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ANEXO A – Código para resolução do modelo de Programação Linear 

 

# Import de todas as bibliotecas 

 

import pulp 

from pulp import * 

import pandas as pd 

import numpy as np 

In [ ]: 
# Abrindo arquivos de id, oferta, demanda e distâncias 

 

## identificador de oferta 

with open('df_oferta_final.csv','r') as df_oferta: 

    id_oferta = list(map(str,pd.read_csv(df_oferta, sep=',', header=0, 

names=('id_oferta', 'valor_oferta')).iloc[:,0])) 

                               

## oferta 

with open('df_oferta_final.csv','r') as df_oferta: 

    oferta = list(map(int,pd.read_csv(df_oferta, sep=',', header=0, 

names=('id_oferta', 'valor_oferta')).iloc[:,1])) 

     

## identificador de demanda 

with open('df_demanda_final.csv','r') as df_demanda: 

    id_demanda = list(map(str,pd.read_csv(df_demanda, sep=',', header=0, 

names=('id_demanda', 'valor_demanda')).iloc[:,0])) 

     

## demanda 

with open('df_demanda_final.csv','r') as df_demanda: 

    demanda = list(map(int,pd.read_csv(df_demanda, sep=',', header=0, 

names=('id_demanda', 'valor_demanda')).iloc[:,1])) 

     

## distâncias  

with open('df_distancias_final.csv') as df_distancias: 

    distancias = pd.read_csv(df_distancias) #, sep=',', header=0, 

names=('id_oferta', 'valor_oferta'))) 

 

#Apesar de nao estar explicito, a matriz de distancias tem os valores das 

PAs nas linhas e dos MAN nas colunas.  

#Na tabela a seguir foi removido o indice com os valores das PAs 

distancias = distancias.T 

In [ ]: 
# Definindo problema de programação linear 

prob = LpProblem('Otimizacao_CE_Cenário_Atual', LpMinimize) 

In [ ]: 
# Definindo as variáveis de decisão do problema 

Varx = LpVariable.dicts('Varx', [(MAN,PA) for MAN in range(len(oferta)) for 

PA in range(len(demanda))], 0, None, LpInteger) 

In [ ]: 
# Definindo a função objetivo do problema 

#prob += lpSum([distancias.iloc[PA,MAN] * demanda[PA] * Varx[MAN,PA] for 

MAN in range(len(oferta)) for PA in range(len(demanda))]) 

prob += lpSum([demanda[PA] * distancias.iloc[MAN, PA] * Varx[MAN, PA]   for 

PA in range(len(demanda)) for MAN in range(len(oferta))]) 

In [ ]: 
# Definindo as restrições do problema 
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## restrição de oferta 

for MAN in range(len(oferta)): 

    prob += lpSum([Varx[MAN,PA] * demanda[PA] for PA in 

range(len(demanda))]) <= oferta[MAN] 

     

## restrição de demanda    

for PA in range(len(demanda)):     

    prob += lpSum([Varx[MAN,PA] for MAN in range(len(oferta))]) == 1 

In [ ]: 
prob.writeLP("PG_Otimização_das_Rotas_-_CE_Cenário_Atual.lp") 

In [ ]: 
prob.solve() 

In [ ]: 
print('A Km final total e de: '+str(value(prob.objective))+' m')# eu acho 

que esta em metros  

print('A Km final total e de: '+str((value(prob.objective))/1000)+' Km') 

In [ ]: 
# Gerando o arquivo com os resultados  

 

## abrindo os arquivos  

 

### identificador de oferta 

with open('df_oferta_final.csv','r') as df_oferta: 

    id_oferta = list(map(str,pd.read_csv(df_oferta, sep=',', header=0, 

names=('id_oferta', 'valor_oferta')).iloc[:,0])) 

               

                   

### oferta 

with open('df_oferta_final.csv','r') as df_oferta: 

    oferta = list(map(int,pd.read_csv(df_oferta, sep=',', header=0, 

names=('id_oferta', 'valor_oferta')).iloc[:,1])) 

     

     

### identificador de demanda 

with open('df_demanda_final.csv','r') as df_demanda: 

    id_demanda = list(map(str,pd.read_csv(df_demanda, sep=',', header=0, 

names=('id_demanda', 'valor_demanda')).iloc[:,0])) 

     

### demanda 

with open('df_demanda_final.csv','r') as df_demanda: 

    demanda = list(map(int,pd.read_csv(df_demanda, sep=',', header=0, 

names=('id_demanda', 'valor_demanda')).iloc[:,1])) 

     

## organizando os ids e os resultados     

oferta_ids = [] 

ofertas = [] 

 

for id in id_oferta: 

    id = int(id) 

    oferta_ids.append(id) 

for i in range(len(oferta)): 

    i = int(i) 

    ofertas.append(i) 

transform_oferta = list(zip(oferta_ids,ofertas)) 
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demanda_ids = [] 

demandas = [] 

 

for id in id_demanda: 

#    id = int(id) 

    demanda_ids.append(id) 

for i in range(len(demanda)): 

    i = int(i) 

    demandas.append(i) 

transform_demanda = list(zip(demanda_ids,demandas)) 

     

resultados = [] 

for i in prob.variables(): 

    if i.varValue > 0: 

        variável, valor = i.name, i.varValue 

        resultados.append((variável,valor)) 

         

## salvando os resultados em um dataframe 

df = pd.DataFrame(resultados) 

df.columns = ['variável','valor'] 

transform_oferta = dict(transform_oferta) 

transform_demanda = dict(transform_demanda) 

 

## gerando arquivo csv com os resultados 

resultados_excel = df.to_excel('resultados_cenário_atual.xls') 

resultados_csv = df.to_csv('resultados_cenário_atual.csv') 
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ANEXO B – Código para exportar matrizes 

 

# Importar bibliotecas: numpy, pandas e arcpy 

import pandas as pd 

import numpy as np 

import os 

In [ ]: 
# Explicitar quais campos (fields) da tabela deverão ser coletados 

colunas = ["XCoord", "YCoord", "ObjectID", "DestinationRank", "Total_Time", 

"Total_Distance", "OriginOID", "OriginName", "DestinationOID", 

"DestinationName", "Shape_Length"] 

 

# Explicitar quais matrizes foram geradas pelo ArcGIS Pro 

dados_1 = pd.read_csv(r'Matriz de Distancias - ETAs 1.txt', sep=';') 

dados_2 = pd.read_csv(r'Matriz de Distancias - ETAs 2.txt', sep=';') 

dados_3 = pd.read_csv(r'Matriz de Distancias - ETAs 3.txt', sep=';') 

dados_4 = pd.read_csv(r'Matriz de Distancias - ETAs 4.txt', sep=';') 

dados_5 = pd.read_csv(r'Matriz de Distancias - ETAs 5.txt', sep=';') 

 

dados = 

dados_1.append(dados_2).append(dados_3).append(dados_4).append(dados_5) 

 

# Tranformar dados para estrutura de dataframe do biblioteca pandas e 

prepará-los para manipulação 

df = pd.DataFrame(dados, columns = colunas) 

 

df.drop(["XCoord", "YCoord", "ObjectID", "DestinationRank", "Total_Time", 

"OriginOID", "DestinationOID", "Shape_Length"], axis = 1, inplace = True) 

df.rename({"Total_Distance": "Distancia"}, axis = 1, inplace = True) 

 

df['DestinationName'] = df['DestinationName'].astype('string') 

df['OriginName'] = df['OriginName'].astype('string') 

df['Distancia'] = df['Distancia'].astype('int') 

     

# Gerar uma única matriz de distâncias 

     

matriz_distancias = df.pivot(index = "DestinationName", columns = 

"OriginName", values = "Distancia") 

matriz_distancias_excel = matriz_distancias.to_excel('matriz_final.xls') 

matriz_distancias_csv = matriz_distancias.to_csv('matriz_final.csv') 

In [ ]: 
matriz_distancias 
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ANEXO C – Passo a passo das ferramentas Weighted Overlay e Generate O/D Matrix 

 
Passo a passo - até a ferramenta weighted overlay 

 

Definindo o sistemas de coordenadas do projeto: 

 

 

1. Map > Properties > Coordinates Systems > [ Projected Coordinate 
System ] [ SIRGAS 2000 UTM Zone 24S ] 

 

Adicionando o mapa do Estado de Ceará e seus municípios [ IBGE ] 

 

 

1. Baixar dados de municípios pelo site do IBGE - Geociências 
2. Adicionar dados no Arcgis Pro  

a. Add data > Add data to the map > [ CE_Municipios_2020.shp ] 

3. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ CE_Municipios_2020 ] > Output [ 

Current Map [ Map ] ] 

 

Construindo o mapa de volume demandado ou ofertado de água [ IBGE ] 

 

 

1. Adicionar dados no Arcgis Pro 
a. Add data > Add data to the map > [ Dados de volume demandado/ofertado 

] 

2. Transformar tabela em pontos no mapa 
 . Analysis > Tools > XY Table to point >  Input [ Tabela - Dados de 

volume demandado/ofertado ]  Coordinate System [ CE_Municipios_2020 (mapa 

original sem ser o projetado, no sistema de coordenados geográfico = SIRGAS 

2000) ] 

3. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ Mapa - Dados de volume 

demandado/ofertado ] > Output [ Current Map [ Map ] ] > Run 

4. Construir mapa de calor (ou Densidade de Kernel) com as informações 
de volume de água demandado ou ofertado 

 . Analysis > Tools > Kernel Density > Input [ Mapa - Dados de volume 

demandado/ofertado ] Population Field [ Volume de água demandado/ofertado ] 

Output cell size [ 100 ] > Environments > Processing Extent > Extent [ 

Current Display Extent ] > Run 

5. Cortar mapa raster no formato do Estado de Ceará  

 . Analysis > Tools > Clip Raster > Input Raster [ Mapa - Dados de 

volume demandado/ofertado ] Output Extent [ Mapa do Estado de Ceará_Proj ] 

Check [☑] Use Input Features for Clipping Geometry  Check [☑] Maintain 

Clipping Extent > Run 

6. Reclassificar a simbologia dos valores do mapa de calor (ou Densidade 
de Kernel) 

 . Analysis > Tools > Reclassify > Input Raster [ Mapa - Dados de volume 

demandado/ofertado ] > Classify > Method [ Quantile ] Classes [ 5 ]  Check 

[☑] Change missing values to NoData > Run 

 

Construindo o mapa de estresse de água [ ONU ] 

 

 

1. Adicionar dados no Arcgis Pro 
b. Add data > Add data to the map > [ Dados de estresse de água ] 

OU [ Base de Dados Geográficos do 

Aqueduct/y2019m07d12_aqueduct30_v01.gdb  ] 

2. Selecionar a área de interesse - Estado do Ceará - através dos 

atributos  
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a. Attribute Table > Select by attributes > Selection Type [ Select 

subset from the current selection ] > Expression [ New expression ] >  

i. Where [ name_0 ] is equal [ Brazil ] > Add Clause 

ii. Where [ name_1 ] is equal [ Ceará ] > Apply 

3. Exportar dados para criação do mapa no Arcgis Pro 

 . Data > Export Features > Expression [ New expression ] >  

 . Where [ name_0 ] is equal [ Brazil ] > Add Clause 

i. Where [ name_1 ] is equal [ Ceará ] > OK 

4. Projetar mapa no sistemas de coordenadas do projeto 

 . Analysis > Tools > Project > Input [ Mapa - Dados de estresse de água 

] Output [ Current Map [ Map ] ] > Run 

5. Transformar layer em raster  

 . Analysis > Tools > Polygon to Raster > Input [ Mapa - Dados de 

estresse de água ] Value Field [ bws_raw ] Cell Size [ 100 ] > Run 

6. Cortar mapa raster no formato do Estado de Ceará 

 . Analysis > Tools > Clip Raster > Input Raster [ Mapa - Dados de 

estresse de água ] Output Extent [ Mapa do Estado de Ceará_Proj ] Check 

[☑] Use Input Features for Clipping Geometry  Check [☑] Maintain Clipping 

Extent > Run 

7. Reclassificar a simbologia dos valores do mapa de calor (ou Densidade 

de Kernel) 

a. Analysis > Tools > Reclassify > > Input Raster [ Mapa - Dados de 

estresse de água ] > Classify > Method [ Manual Interval (0 - 0.1; 0.1 - 

0.2;0.2 - 0.4; 0.4 - 0.8; 0.8 - 1) ] Classes [ 5 ]  Check [☑] Change 

missing values to NoData > Run 

 

Construindo o mapa de distâncias euclidianas entre PAs e MANs [ Reinaldo 

Garcia ] 

 

 

1. Adicionar dados no Arcgis Pro 
a. Add data > Add data to the map > [ Dados de coordenadas geográficas 

por PA/MAN ]  

2. Transformar tabela em pontos no mapa 
 . Analysis > Tools > XY Table to point > Input [ Tabela - Dados de 

coordenadas geográficas por PA/MAN ] Coordinate System [ CE_Municipios_2020 

(mapa original sem ser o projetado, no sistema de coordenados geográfico = 

SIRGAS 2000) ] > Run 

3. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ Mapa - Dados de coordenadas 

geográficas por PA/MAN ] > Output [ Current Map [ Map ] ] > Run 

4. Calcular distâncias euclidianas entre PAs e MANs 
 . Analysis > Tools > Euclidean Distance > Input Raster [ Mapa - Dados 

de coordenadas geográficas por PA/MAN ] > Output cell size [ 100 ] > 

Environments > Environments > Processing Extent > Extent [ Current Display 

Extent ] > Run 

5. Cortar mapa raster no formato do Estado de Ceará 
 . Analysis > Tools > Clip Raster > Input Raster [Mapa - Dados de 

distâncias euclidianas entre PAs/MANs ] Output Extent [ Mapa do Estado de 

Ceará_Proj ] Check [☑] Use Input Features for Clipping Geometry  Check 

[☑] Maintain Clipping Extent > Run 

6. Reclassificar a simbologia dos valores do mapa de calor (ou Densidade 
de Kernel) 

 . Analysis > Tools > Reclassify > > Input Raster [ Mapa - Dados de 

distâncias euclidianas entre PAs/MANs ] > Classify > Method [ Quantile ] 

Classes [ 5 ]  Check [☑] Change missing values to NoData > Run 

i. Para MANs: inverter a ordem, pois quanto a menor a distância entre os 

mananciais, melhor é a localização de uma ETA 

ii. Para PAs: não inverter! 
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Construindo o mapa de ganho de otimização por PAs e MANs [ Reinaldo Garcia 

] 

 

 

1. Adicionar dados no Arcgis Pro 
a. Add data > Add data to the map > [ Dados de ganho de otimização por 

PA/MAN ] 

 

2. Transformar tabela em pontos no mapa 
 . Analysis > Tools > XY Table to point >  Input [ Tabela - Dados de 

ganho de otimização por PA/MAN ]  Coordinate System [ CE_Municipios_2020 

(mapa original sem ser o projetado, no sistema de coordenados geográfico = 

SIRGAS 2000) ] 

 

3. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ Mapa - Dados de ganho de 

otimização por PA/MAN ] > Output [ Current Map [ Map ] ] 

 

4. Construir mapa de calor (ou Densidade de Ponto) com as informações de 
volume de água demandado ou ofertado 

 . Analysis > Tools > Point Density > Input [ Mapa - Dados de ganho de 

otimização por PA/MAN ] Population Field [ Ganho de Otimização ] Output 

cell size [ 100 ] > Environments > Processing Extent > Extent [ Current 

Display Extent ] > Run 

 

5. Cortar mapa raster no formato do Estado de Ceará  

 . Analysis > Tools > Clip Raster > Input Raster [  Mapa - Dados de 

ganho de otimização por PA/MAN  ] Output Extent [ Mapa do Estado de 

Ceará_Proj ] Check [☑] Use Input Features for Clipping Geometry  Check 

[☑] Maintain Clipping Extent > Run 

 

6. Reclassificar a simbologia dos valores do mapa de calor (ou Densidade 
de Kernel) 

 . Analysis > Tools > Reclassify > Input Raster [ Mapa - Dados de volume 

demandado/ofertado ] > Classify > Method [ Quantile ] Classes [ 5 ]  Check 

[☑] Change missing values to NoData > Run 

 

 

Escolhendo a ótima localização das Estações de Tratamento de Água - ETAs 

 

 

1. Escolher localização ótima das ETAs através da ferramenta Weighted 
Overlay, Sobreposição ponderada em português 

a. Analysis > Tools > Weighted Overlay > Parameters > Weighted overlay 

table > Add New Rasters Datasets: 

i. [ Mapa - Dados de volume demandado/ofertado ]  

ii. [ Mapa - Dados de estresse de água ]  

iii. [ Mapa - Dados de distâncias euclidianas entre PAs/MANs ]  

iv. [ Mapa - Dados de ganho de otimização por PA/MAN  ]  

 

 

b. … > Sum of influences: 
i. [ Mapa - Dados de volume demandado ] [ 10 ]  

ii. [ Mapa - Dados de volume ofertado ]  [ 10 ]  

iii. [ Mapa - Dados de estresse de água ] [ 10 ]  

iv. [ Mapa - Dados de distâncias euclidianas entre PAs ] [ 20 ]  

v. [ Mapa - Dados de distâncias euclidianas entre MANs ] [ 20 ]  

vi. [ Mapa - Dados de ganho de otimização por PA ] [ 15 ] 

vii. [ Mapa - Dados de ganho de otimização por MAN ] [ 15 ]  
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c. … > Value > Scale: 
i. [ Mapa - Dados de volume demandado/ofertado ] & [ Mapa - Dados de 

ganho de otimização por MAN ]: 

• 1 - [ Restricted ]  

• 2 - [ 2 ]  

• 3 - [ 3 ]  

• 4 - [ 4 ]  

• 5 - [ 5 ]  

ii. [ Mapa - Dados de estresse de água ] & [ Mapa - Dados de distâncias 

euclidianas entre PAs ] & [ Mapa - Dados de distâncias euclidianas entre 

MANs ]: 

• 1 - [ 1 ]  

• 2 - [ 2 ]  

• 3 - [ 3 ]  

• 4 - [ 4 ]  

• 5 - [ 5 ]  

iii. [ Mapa - Dados de ganho de otimização por PA ] 

• 1 - [ Restricted ]  

• 2 - [ Restricted ]  

• 3 - [ 3 ]  

• 4 - [ 4 ]  

• 5 - [ 5 ] 

d. … > Scales [ 1 -5 ] > Run  

 

 

2. Selecionar os valores interesse para escolha da localização das ETAs 

a. Symbology > *Mudar para  [ no color ] as áreas de menor interesse 

para destacar aquelas de ótima localização para as ETAs* 

 

3. Selecionar 3 pontos de localização de ETAs 

 . Analysis > Tools > Create Feature Class > Feature Class Location [ 

PG_Otimização da Localização - CE 2.gdb ] Feature Class Name [ 

PG_Localização da Estação de Tratamento de Água_Cenários ] Geometry Type [ 

Multipoint ]  Coordinate Systems [SIRGAS_2000_UTM_Zone_24S] > Run 

i. Ou ver as coordenadas geográficas e adicionar ao documento original 

de coordenadas dos mananciais 

 

4. Adicionar as coordenadas geográficas das 3 ETAs no Arcgis Pro 

 . Add data > Add data to the map > [ Dados de coordenadas geográficas 

das ETAs ] 

 

5. Transformar tabela em pontos no mapa 

 . Analysis > Tools > XY Table to point >  Input [ Tabela - DDados de 

coordenadas geográficas das ETAs ]  Coordinate System [ CE_Municipios_2020 

(mapa original sem ser o projetado, no sistema de coordenados geográfico = 

SIRGAS 2000) ] 

 

6. Projetar mapa no sistemas de coordenadas do projeto 

 . Analysis > Tools > Project > Input [ Mapa - Dados de coordenadas 

geográficas das ETAs ] > Output [ Current Map [ Map ] ] > Run 

 

Passo a passo - usando a ferramenta Network Analysis 

 

Definindo o sistemas de coordenadas do projeto: 

 

 

1. Map > Properties > Coordinates Systems > [ Projected Coordinate 
System ] [ SIRGAS 2000 UTM Zone 24S ] 
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Adicionando o mapa do Estado de Ceará e seus municípios [ IBGE ] 

 

 

1. Baixar dados de municípios pelo site do IBGE – Geociências 
 

2. Adicionar dados no Arcgis Pro  
a. Add data > Add data to the map > [ CE_Municipios_2020.shp ] 

 

3. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ CE_Municipios_2020 ] > Output [ 

Current Map [ Map ] ] > Run 

 

Adicionando as coordenadas geográficas dos pontos de origens e destinos 

 

 

1. Adicionar dados no Arcgis Pro 
a. Add data > Add data to the map > [ Dados de Localização das ETAs+MANs 

e PAs.csv ] 

 

2. Transformar tabela em pontos no mapa 
 . Analysis > Tools > XY Table to point >  Input [ Tabela - Dados de 

Localização das ETAs+MANs e PAs ]  Coordinate System [ CE_Municipios_2020 

(mapa original sem ser o projetado, no sistema de coordenados geográfico = 

SIRGAS 2000) ] 

 

3. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ Mapa - Dados de Localização das 

ETAs+MANs e PAs ] > Output [ Current Map [ Map ] ] > Run 

 

Obs.: Não esquecer de adicionar a informação dos nomes dos MANs e PAs como 

uma coluna entitulada de “Name”, para que a matriz gerada no final esteja 

com essa info associada  

 

Adicionando as informações do Open Street Map 

 

 

1. Adicionar dados shape file do OpenStreetMap no Arcgis Pro 
a. Add data > Add data to the map > [ gis_osm_roads_free_1.shp ] 

 

2. Projetar mapa no sistemas de coordenadas do projeto 
 . Analysis > Tools > Project > Input [ Mapa - Dados do OSM - 

gis_osm_roads_free_1.shp ] > Output [ Current Map [ Map ] ] > Run 

 

3. Cortar mapa shape file no formato do Estado de Ceará 
 . Analysis > Tools > Clip > Input Features or Dataset [ Mapa - Dados do 

OSM - gis_osm_roads_free_1.shp ] Output Extent [ Mapa do Estado de 

Ceará_Proj ] Check [☑] Use Input Features for Clipping Geometry  Check 

[☑] Maintain Clipping Extent > Run 

 

4. Dissolver mapa shape file 
 . Analysis > Tools > Dissolve > Input Features [ Mapa - Dados do OSM - 

gis_osm_roads_free_1.shp ] Check [☑] Create multipart features  Check [☑] 

Unsplit lines > Run 

 

5. Construir linhas a partir dos mapas dissolvidos 
 . Analysis > Tools > Feature to Line > Input Features [Mapa - Dados do 

OSM - gis_osm_roads_free_1.shp ] > Run 

 

6. Adicionar colunas de comprimento, tempo e velocidade 
 . Attribute Table > Add Field >  
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i. [ Length Data Type Double ] > Save 

ii. [ Hours Data Type Double ] > Save 

iii. [ Speed Data Type Double ] > Save 

 

a. Calculate Geometry > 

 . Field [ Length ] Property [ Length ] Length Unit [ Meters ] 

Coordinate Systems [ Mapa do Estado de Ceará_Proj ]> OK 

 

b. Calculate Fields > 

 . [ Hours Data Type Double ] > !Length!/(1000*!Speed!) > Apply > OK 

i. [ Speed Data Type Double ] > 60 > Apply > OK 

 

7. Criar um feature dataset 
 . Analysis > Tools > Create Feature Dataset > Output Geodatabase [ Nome 

do Banco de dados geográficos ] > Feature Dataset Name [ Dataset OSM Roads 

] > Coordinate Systems [SIRGAS_2000_UTM_Zone_24S] > Run 

 

8. Importar as informações de ruas do shape file para o feature dataset 
 . View > Catalog Pane > Folders > Nome do Banco de dados geográficos > 

Dataset OSM Roads > Import > Feature Classes [ Mapa - Dados do OSM - 

gis_osm_roads_free_1.shp ] 

a. OU:  

 . Analysis > Tools > Feature Class to Feature Class > Input Features [ 

Mapa - Dados do OSM - gis_osm_roads_free_1.shp ] > Output Location [ 

Dataset OSM Roads ] > Output Name [ ND OSM Roads ] > Run  

 

9. Criar um network dataset 
 . Analysis > Tools > Create Network Dataset > Target Feature Dataset [ 

Dataset OSM Roads ] > Network Dataset Name [ Dataset OSM Roads ] > Source 

Feature Classes [ ND OSM Roads ] > Run 

 

10. Criar um network analysis layer 

 . Analysis > Network Analysis > Origin-Destination Cost Matrix > Target 

Feature Dataset [ Dataset OSM Roads ] > Network Dataset Name [ Dataset OSM 

Roads ] > Source Feature Classes [ ND OSM Roads ] > Run 

 

11. Calcular as distâncias usando a ferramenta Generate Origin 

Destination Cost Matrix 

 . Analysis > Network Analysis > Origin-Destination Cost Matrix > Target 

Feature Dataset [ Dataset OSM Roads ] > Network Dataset Name [ Dataset OSM 

Roads ] > Source Feature Classes [ ND OSM Roads ] > Run 

 

12. Fazer download em csv das matrizes de distância geradas  

Analysis > Export Featue Attribute to ASCII  > Origin-Destination Cost 

Matrix > Target Feature Dataset [ Dataset OSM Roads ] > Network Dataset 

Name [ Dataset OSM Roads ] > Source Feature Classes [ ND OSM Roads ] > Run 

 

Links 

https://www.esri.com/arcgis-blog/products/product/imagery/aqueduct-a-new-

tool-for-measuring-mapping-and-understanding-water-risks-worldwide/ 

https://www.youtube.com/watch?v=00XPWWVuE5U 

https://www.youtube.com/watch?v=00XPWWVuE5U 

https://www.youtube.com/watch?v=6G00dW3d7X8 

https://www.youtube.com/watch?v=6G00dW3d7X8 

https://www.youtube.com/watch?v=6G00dW3d7X8 

https://www.youtube.com/watch?v=9abwIF7nTxI&list=PLVCj1g2IONu4A1S94Jpb5UsY7

HF_qRU9L 

https://www.youtube.com/watch?v=cw7dbkHsYu8 

https://www.youtube.com/watch?v=IxRfaON00RQ 

https://www.youtube.com/watch?v=LP40ElLh6XM&t=207s 

https://www.youtube.com/watch?v=QChJSKb_EAM 

https://www.esri.com/arcgis-blog/products/product/imagery/aqueduct-a-new-tool-for-measuring-mapping-and-understanding-water-risks-worldwide/
https://www.esri.com/arcgis-blog/products/product/imagery/aqueduct-a-new-tool-for-measuring-mapping-and-understanding-water-risks-worldwide/
https://www.youtube.com/watch?v=00XPWWVuE5U
https://www.youtube.com/watch?v=00XPWWVuE5U
https://www.youtube.com/watch?v=6G00dW3d7X8
https://www.youtube.com/watch?v=6G00dW3d7X8
https://www.youtube.com/watch?v=6G00dW3d7X8
https://www.youtube.com/watch?v=9abwIF7nTxI&list=PLVCj1g2IONu4A1S94Jpb5UsY7HF_qRU9L
https://www.youtube.com/watch?v=9abwIF7nTxI&list=PLVCj1g2IONu4A1S94Jpb5UsY7HF_qRU9L
https://www.youtube.com/watch?v=cw7dbkHsYu8
https://www.youtube.com/watch?v=IxRfaON00RQ
https://www.youtube.com/watch?v=LP40ElLh6XM&t=207s
https://www.youtube.com/watch?v=QChJSKb_EAM
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https://www.youtube.com/watch?v=tVHJXZnVO8E&t=40s 

https://www.youtube.com/watch?v=tVHJXZnVO8E&t=40s 

https://www.youtube.com/watch?v=uK22 IQGw 

https://www.youtube.com/watch?v=WK4PURk1GzY 

 

https://www.youtube.com/watch?v=tVHJXZnVO8E&t=40s
https://www.youtube.com/watch?v=tVHJXZnVO8E&t=40s
https://www.youtube.com/watch?v=uKRCu22IQGw
https://www.youtube.com/watch?v=WK4PURk1GzY

